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1 M1 philosophy
 

1 M1 philosophy
With the M1 pattern workstation you can generate the knitting programs 
(Sintral) for all the CMS knitting machines of the company Stoll. Starting 
with a draft, the patterns are entered graphically by inserting modules or by 
editing pattern elements. For this purpose, different presentations (views) 
are available in the M1 main program. The changes which are made in one 
view will be updated immediately in the other one.

Fig. 1-1 Draft as a basis for a knitting program

The M1 main program is enhanced by a series of other programs. 
Depending on the pattern type, different programs are used, e.g. for 
module management, shape editing or data exchange. Knitting programs 
are then generated from the finished patterns. These programs can be 
processed by the knitting machines.

The following pattern types can be created with the M1 pattern 
workstation:

� Pattern without shape  

� Fully fashion pattern  

� Knit and wear (k&w pattern)
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M1 philosophy 1
The basic steps for creating a new pattern are different, depending on the 
pattern type:

Pattern without shape Fully fashion patterns k&w pattern

 

Select a new pattern in M1 main program  [see page 12] and select a machine from the machine database.

Select basic pattern and start from the module database. Select k&w basic pattern from the 
module database.

 Select shape.  

 

Editing a pattern in fabric view  [see page 13] and technical view  [see page 18]:
- Insert modules via module bar  [see page 66] from the module database.
- Generate, edit and insert pattern elements.
- Insert drawing tools  [see page 57] and yarn colors  [see page 59].
- Create and insert jacquards in the jacquard editor  [see page 30].

 

To expand basic patterns to fully fashion patterns, create a shape in the 
shape editor  [see page 20] or open and position a shape.

Open a k&w shape or create one 
and position it.

 Edit shape in the shape view  
[see page 20].

Arrange knitting cycles and edit 
shape in the shape view  
[see page 20].

 Use shape. Use shape and select start.

 

Edit pattern parameters in the pattern parameter tables and enter technical row data.

Assign yarn carriers in yarn field view  [see page 26].

 

Perform technical editing in the technical assistant and generate Sintral.

Check Sintral in Sintral check and calculate, for example, knitting time and yarn consumption.

Save knitting program in an image file, to the Knit Memory Card (KMC) or to a floppy disk and load data to machine.
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1 M1 philosophy
 

In addition, you can perform the following tasks with the programs of the 
M1 pattern workstation:

� Manage machine data in the machine explorer and save in the 
machine database.  

� Edit modules in the module explorer, create pattern elements and save 
in the module database.  

� Arrange views in the overview window.  

� Generate or edit shapes in the Shape editor:  

� Edit DXF shapes in the DXF toolkit and prepare them for import in 
Shape editor.  

� Edit or generate knitting cycles with the knitting cycle editor  .  

� Create k&w shape with Shape Wizard and determine knitting cycles.  

� Create k&w shapes of different sizes with ShapeSizer  .  

� Import pictures.  

� Edit knitting program in Sintral editor.  

� Edit order menu in the Order program.  

� Edit sequences in the sequence editor and sequence lists in the 
sequence list editor.  

� Split pattern.  

� Edit STOLL Knit Memory Cards and generate KMC with the machine 
operating system.

The chapter structure of the M1 help is oriented based on the basic steps 
and the structure of the program. In addition to the description of the M1 
explorer and the M1 main program, you can find information on the 
different programs (e.g. shape editor) in the relevant chapters (e.g. 
Working with shape knitting).
4



Set up M1 pattern workstation 2
2 Set up M1 pattern workstation
You get the STOLL pattern software M1 on CD or DVD for the installation 
on a pc with the MS Windows XP operating system.

In order to set up the Stoll pattern software M1 on you computer you have 
to:

➜ order the licence key at Stoll 

➜ install the Stoll pattern software M1
5



2 Set up M1 pattern workstation
2.1 Change language
2.1 Change language
You can change the language of the M1 interface without reinstalling the 
software.
For this purpose select the desired languages when installing the M1 in 
order that they are installed for a later switch.

Selected components (e.g. languages for interfaces of the M1 program) 
can be installed at a later time or removed individually.

Change the language:

� The desired languages had been selected when installing the M1.  
� All M1 programs are shut down.

1. Call up the "All Programs/Stoll M1/Change Language" function in the 
Windows Start menu.
-> The Change M1 Language program starts.  

2. Select the desired language an confirm with "Select".  
After switching the language the M1 program starts with the newly set 
language.

Applies only to the STOLL pattern workstation M1 (Component type 000 to 
003) or computer with the multilingual operating system
In order to change the language of windows menus and dialog boxes click 
on "Start" / "System control" / "Date, Time, Language and Regional 
Options" / "Regional and Language Options".
The M1 program uses partly these window elements.
Component type 003 of the pattern workstations M1 has an integrated 
switch of languages.
Refer to the setup manual.
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Help on Help 3
Change language 2.1
3 Help on Help

Fig. 3-1 Start page of the M1 help function
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3 Help on Help
2.1 Change language
The following functions are contained in the symbol bar of the M1:

The following functions are contained in the "Options" menu:

Function Target

"Fade out" Hiding the left navigation bar with the three tabs Contents, 
Index and Find.

Note: Only available with the navigation bar displayed.

"Display" Showing the left navigation bar with the three tabs 
Contents, Index and Find.

Note: Only available with the navigation bar is hidden.

"Back" Switching to the last displayed page.

Note: Only available when you have already jumped to 
another page.

"Print" Printing displayed page.

"Options" Opening menu with additional options.

Function Target

"Hide tabs"/
"Display tabs"

Hide/show navigation bar with registers.

"Back" Switching to the last displayed page.
Note: Only available when you have already 
jumped to another page.

"Forward" Change to the next page.

"Start page" Change to start page.

"Cancel" Cancel action.

"Update" Update screen display of the M1 help 
function.

"Internet options" Setting Internet browser.

"Print" Printing displayed page.

"Deactivate search term 
highlighting"/
"Activate search term 
highlighting"

Hide/show highlighting of search terms in the 
sites found.
8



Help on Help 3
Change language 2.1
The following elements are contained in the navigation bar of the M1 help:

Element Meaning

"Contents" tab Display table of contents of M1 help.

"+" Display subdirectories by clicking on the + 
symbol.

"-" Hide subdirectories by clicking on the - 
symbol.

"Index" tab Display key word directory.

Input field
"Find key word"

Enter a search term in the input field to jump 
to the corresponding entry in the index.

"Display" button Displaying the page selected in the key word 
directory.

"Search" tab Display search function for the entire 
document

Input field
"Find key word"

Enter a search term in the input field to 
display pages with the desired key word in the 
navigation bar.

"List of topics" button Start search via M1 help.

"Display" button Display pages selected on the tab.

"Favorites" tab Display list of favorites.

"Remove" button Remove favorites from the list.

"Display" button Display favorite.

Input field
"Current topic"

Change name of the current page for the list 
of favorites.

"Add" button Copy current page to list of favorites.
9



3 Help on Help
3.1 Calling up M1 help
3.1 Calling up M1 help
The M1 pattern workstation is provided with an online help feature in which 
all functions and their use are described.

I. Calling up context-sensitive help:

1. Click on the icon  in the "Default" toolbar.
-> A question mark also appears on the cursor.  

2. Click on a position within the M1 for which help is desired.
- or -
Position the cursor on a position within the M1 for which help is desi-
red.  

3. Press "F1" key of the keyboard.  

Help on the selected function appears.

With the icon  additional help topics can be displayed in some cases that 
are not accessible with the "F1" key.
If you have questions on working withe the Windows operating system, 
change to the Windows online help.

II. Start online help:

➜ Run the "Help Topics" function in the "?" menu.
The online help is started and displayed in the M1 help window.

Further information
Help Topics
10



Help on Help 3
Symbols of the M1 help 3.2
3.2 Symbols of the M1 help
The following symbols are contained in the headers or footnotes of an M1 
help page:

 Function Target

In the header

Back Return to the previous subject.
The title of the previous subject appears in the tip 
text.

Continue Continue to the next subject.
The title of the next subject appears in the tip text.

Higher-level topic Switch to higher-level subject.
The title of the higher-level subject appears in the 
tip text.

Start page Change to the start page.
In the tip text appears the M1 help.

Glossary Switch to glossary.
The glossary contains a list of knitting terms and 
terms typical for the M1.
Glossary appears in the tip text.

Homepage Call up Stoll coustomer homepage.
Here you will find everything worth knowing about 
the M1 pattern workstation. With your coustomer 
number and your PIN you will find In the M1 
customer-net not only FAQs and Tips and Tricks, 
but also a large number of download functions. 
Stoll Customer Support appears in the tip text.

In the foot notes

Top of page Jump to top of page.
This icon is located on the right at the end of the 
page and enables you to return quickly to the top 
of the page with the navigation bar. No tip text 
appears.
11



3 Help on Help
3.2 Symbols of the M1 help
The following information symbols are contained on a M1 help page:

Tip texts which explain the symbols are allocated to the symbols on the 
online pages of the M1 help. To display the tip texts, place the cursor over 
a symbol while M1 help is active. The explanation on the respective icon 
appears in a tip text field with a yellow background.

 Information Meaning

Note Notes to be observed during your procedure are 
located to the right next to this icon. Note 
appears in the tip text.

Requirements You will find the requirements for executing the 
following procedural instructions to the right of 
this symbol. Requirement appears in the tip text.

Target The targets which are to be reached with the 
following procedural instructions are described to 
the right of this symbol. Target appears in the tip 
text.

Result On the right of this symbol there is the result of 
an action or a series of actions which has been 
described previously. Result appears in the tip 
text.

Tip Tips for a simpler or better procedure are located 
to the right of this icon. Tip appears in the tip text.
12



M1 main program 4
Symbols of the M1 help 3.2
4 M1 main program

Fig. 4-1 Graphical interface in M1 main program
13



4 M1 main program
3.2 Symbols of the M1 help
The individual components of the graphical interface:

If you are very new to working with a Windows PC, please read the 
corresponding introduction in the manual for the Windows operating 
system, or display the Windows online help.

No. Part Function

1 Menu bar  
[see page 34]

A list of functions ("menu items"), that are displayed at the upper edge of the 
window.

2 Context menu The menu shown when you click on an object with the right mouse button.

3 Symbol Toolbar  
[see page 53]

A number of buttons that can be clicked to execute frequently used tasks.

4 Module Bar  
[see page 66]

Module selection option.
Various module groups can be selected for display.

5 Fabric view  
[see page 13]

Graphic 3D presentation of the pattern.

6 Technical view  
[see page 18]

Graphic presentation of all needle actions present in the pattern

7 Shape view/Shape 
editor  [see page 20]

Graphic display of a shape for editing

8 Overview window  
[see page 32]

Simplified presentation of the entire pattern

9 Status line  
[see page 80]

Display line at the lower edge of the screen with information on a function, an 
ongoing process or a position

 Jacquard editor  
[see page 30]

Graphic display and editing program for the MC jacquard (*.-jac) and the MC 
jacquard source file (*.jdv)

 

 Window heading Contains the name of the window or the dialog box

 Quickinfo A brief description of a screen element. The tip text is displayed when you 
position the mouse pointer over an element.

 Cursor Also mouse pointer
An icon that is displayed on the screen and controlled by moving the mouse 
(normally an arrow). Use the cursor to work with menus, icons, links and other 
screen elements.

 Task bar A tool with which you can open programs and move through elements on the 
computer. The task bar is normally located at the lower edge of the screen and 
contains the "Start" button.
14



M1 main program 4
Fabric view 4.1
4.1 Fabric view

Fig. 4-2 3x3 cable and petinet in the fabric view

The fabric view is a window for the graphic entry and true-to-life 
presentation of the pattern. The window has control columns  
[see page 22] with the row numbering on the left-hand side.
The Fabric view works interactively with the Technical view- changes are 
shown immediately in both windows.
This view is particularly well suited for positioning modules and checking 
the structure and appearance of the pattern. 
Whether the fabric view window is automatically displayed for a new or a 
newly opened pattern can be set in the Program settings dialog box (Load 
tab). 
The following information is contained in the header line:

� Fabric view [status display]
The following status displays are possible:

� Pattern name  

� Pattern size in the form pattern width x pattern height (pattern rows/
technical rows)  

� Machine and machine gauge  

� * is shown when the edited pattern has not yet been saved.  

� Numbering of the open window of the fabric and technical views.
This numbering matches that in the "Window" menu.

Status display in [ ] Meaning

Original View before technical editing

Technique View after technical editing

Technical check run View after test run of technical editing

Technique 2 pieces View after the technical editing for two pieces

previous technique View before the last test run
15



4 M1 main program
4.1 Fabric view
The continuous updating of the fabric view requires processing time. 
Close the fabric view or switch to the "color presentation" or "symbol 
presentation" of the fabric view to accelerate updating.

Navigating in the fabric view:

� If the mouse pointer is located within the fabric view, the view is 
scrolled in the direction of the mouse pointer by pressing the "space 
bar".  

� Pressing the "x" key sets the displayed position of the fabric view in all 
other views.

Further information
Technical view  [see page 18]
Technical Editing
16



M1 main program 4
Fabric view 4.1
4.1.1 Context menu (fabric view)
Some functions can also be called up via a context menu. Click on the 
fabric view with the right mouse button.

The following functions are contained in the context menu of the fabric 
view:

Function Target

Show module in Explorer Display and select module of pattern in the 
module explorer.

Edit module Open the module of pattern in the Module 
editor.

Display Front Needle Bed Display or hide front needle bed.

Display Back Needle Bed Display or hide back needle bed.

Protect Front Needle Bed Activate or deactivate write protection for the 
front needle bed.

Protect Back Needle Bed Activate or deactivate write protection for the 
back needle bed.

View From Back Fabric view from back.

Logical Zoom Show right and left stitches next to each 
other.

Displaying multi gauge Highlight multi gauge in fabric.

Display Floats Display floats over at least one needle pair.

Display Starting Stitch as a 
Tuck Stitch

Display stitch on empty needle as tuck.

Display k&w double 
assignment  

Display double assignment in the fabric view.

Dissolve Drop Stitches Show cast-off stitches dissolved.

Display Module Limits Display module limits as frame.

Show Comments Display or hide comments on a pattern.

Comment/new/Text Attach text as comment.

Comment/new/Bitmap Attach picture file as comment

Comment/new/Pin 1 - Pin 4 Attach one of four colored pins as a 
comment.

Comment/next Jump to the next comment.

Comment/previous Jump to the previous comment.

Comment/first Jump to the first comment.

Comment/last Jump to the last comment.

Comment/center current Center currently selected comment.

Comment/edit Edit currently selected comment text.

Comment/delete Delete currently selected comment.

Set Shape Data to the Front  Overlap shape data in the fabric view.
17



4 M1 main program
4.1 Fabric view
Set Shape Data Aside  Highlighting shape data in the fabric view.

Ruler/Horizontal Call up functions to display a ruler.

Ruler/Vertical

Ruler/Go to ruler (H)

Ruler/Go to ruler (V)

Stitch Echo Display pick-up of selection with stitch echo.

Grid Display or hide grid.

Fabric View Display 3D stitch depiction in color.

Color Presentation Display only colors with color steps.

Color Presentation w/o Needle 
Actions

Display only colors without color steps.

Module Color Presentation Display separate color per module.

Symbol Presentation Display symbol display in the color 
presentation.

Symbol Presentation in 
Module Color Presentation

Display symbol display in the module color 
presentation.

Set background color Set background color of window.

Set stitch density Specify stitch ratio for the fabric presentation.

Technical Row Display Show each technical row of a pattern row in 
its own row.

Pattern Row Presentation Show all technical rows of a pattern row in 
one row.

Gore Presentation Display gore folded up.

Cursor/Default/Advanced Call up functions to select between different 
cursor types.

Cursor/Default/Simple

Cursor/Cross Hairs/Advanced

Cursor/Cross Hairs/Simple  

Cursor/Coordinate Display/
Advanced

Cursor/Coordinate Display/
Simple  

Show Cursor Position in All 
Views/Cursor

Save Settings Save window settings.

Function Target
18



M1 main program 4
Technical view 4.2
4.2 Technical view

Fig. 4-3 3x3 cable and petinet in the technical view

The Technical view is a window for the graphic entry and presentation of 
the pattern as a needle action. In this window important pattern data is also 
displayed which can be activated via the buttons of the "Pattern 
presentations" toolbar. The window contains control columns with the row 
numbering and other data to the left and the column numbering in a 
column bar above.
The technical view works interactively with the fabric view- changes are 
shown immediately in both windows.
With the technical view you can assign pattern data. The results of 
technical editing are visible here immediately. 
Whether the technical view window is automatically displayed for a new or 
a newly opened pattern can be set in the Program settings dialog box 
(Load tab). 
The following information is contained in the header line:
19



4 M1 main program
4.2 Technical view
� Technical view [status display]
The following status displays are possible: Original (view before 
technical editing), Technical (view after technical editing), Technical 
test run (view after the technical-editing test run), Technical - 2 pieces 
(view after technical editing for two pieces) and previous technical 
(view before the last technical editing).  

� Pattern name  

� Pattern size in the form pattern width x pattern height (pattern rows/
technical rows)  

� Machine and machine gauge  

� * is shown when the edited pattern has not yet been saved.  

� Numbering of the open window of the fabric and technical views.
This numbering matches that in the "Window" menu.

When you open a pattern, the technical view is located under the fabric 
view. By clicking on the header bar of the window with the left mouse 
button or by selecting it in the "Window" menu, you can bring it into the 
foreground.

Navigating in the technical view:

� If the mouse pointer is located within the technical view, the view is 
scrolled in the direction of the mouse pointer by pressing the "space 
bar".  

� Pressing the "x" key sets the displayed position of the technical view in 
all other views.

Further information
Fabric view  [see page 13]
Technical Editing
Control column  [see page 22]
Context menu (technical view)  
20



M1 main program 4
Shape view/Shape editor 4.3
4.3 Shape view/Shape editor

Fig. 4-4 Shape view of the pattern from Stoll shape 2_set-in-front-v-neck-38.shv

The shape view is a window for the graphic entry and display of the shape 
(elements within shape and outside shape) and its shape attributes for the 
fully fashion pattern and k&w pattern.
21



4 M1 main program
4.3 Shape view/Shape editor
The starting point of the modules inserted as selection in the shape view is 
displayed with a triangle.

The window has control columns  [see page 22] with the row numbering on 
the left-hand side. 
The shape view works interactively with the fabric view and technical view, 
changes are shown immediately in all windows.

The following information is present in the title line:

� Shape View  

� Pattern name  

� Pattern size with the display of the pattern width x pattern height 
(pattern rows/technical rows)  

� Machine and machine gauge  

� * is shown when the edited pattern has not yet been saved.  

� Shape name

With k&w patterns in the shape view before cutting out:
An additional symbol appears at the cursor and displays the area in which 
the cursor is located:
In the sleeve, body or collar; right or left.
You can select a knitting cycle in the module bar with the "F5" key.

A shape can also be saved separately from the pattern as a separate file. 
The open file is shown in an identical window, but with the name Shape 
editor.

Navigating in the shape view:
If the mouse pointer is located within the shape view, the view is scrolled in 
the direction of the mouse pointer by pressing the "space bar". Pressing 
the "x" key sets the displayed position of the shape view in all other views. 
The shape edge to which the cursor is pointing is selected in the table with 
the "F6" key.

Copying in the shape view:
If a selected area in the shape view is copied, the module echo of the 
selection is displayed and the module symbol appears on the mouse 
pointer. If the selection is larger than the displayed section on the screen, 
no module echo is displayed during copying. Only the module symbol 
appears on the mouse pointer.
22



M1 main program 4
Shape view/Shape editor 4.3
4.3.1 Context menu (shape view/shape editor)
Some functions can also be called up via a context menu. Click on the 
shape view or shape editor with the right mouse button.

All functions in the context menu of the shape view or the shape editor are 
identical to the functions of the same name in the "View/Options" menu.

Further information
Options
23



4 M1 main program
4.4 Control columns
4.4 Control columns
You get quickly and in good overview information on the displayed rows in 
the control columns of thetechnical view, the Fabric view and the shape 
view. The data is shown in columns and can be displayed and hidden 
individually or all together.

In Find and Replace dialog box, you can specify data of the control 
columns present in the pattern and which are to be replaced by other data.

The dialog box is opened by the Find and Replace function in the Edit 
menu.

Context menus can be accessed with the right mouse button via some 
columns, and relevant settings for the rows can be selected here.
The selected settings are assigned to one or more rows with the left mouse 
button. This cursor function is deactivated again with the "Esc" key or by 
selecting another cursor function.

In the pattern row presentation are presented not all the control columns. 
You can choose between the "technical row presentation"   and the 
"pattern row presentation"   via the pattern presentation toolbar. The 
numbering of the rows is dependent on the type of presentation.

The following control columns are presented:

� Technical row  

� Pattern row  

� Jacquard  

� Stroke  

� Knitting layer  

� Carriage direction  

� System  [see page 24]  

� Fabric take-down, main take-down, auxiliary take-down, fabric sensor, 
WM%  

� Comb, monitoring of fabric collection chamber  [see page 24]  

� Carriage speed, machine slow, machine stop  

� STIXX  

� Instructions  

� Function call  

� Areas  

� Front hold-down, back hold-down  

� Front stitch length, back stitch length  

� Racking correction  [see page 25]  

� Cycles  

� Yarn carrier  [see page 25]  
24



M1 main program 4
Control columns 4.4
� Front racking, Rear racking, Additional bed racking  

� Selection  [see page 26]

Toggle on all control columns:

➜ Click an icon of the control columns with the right mouse button and 
call up the "Show all columns" function.

Toggle on/off the control columns:

➜ Click an icon of the control columns with the right mouse button and 
call up the "Select columns" function.
The "Select columns" dialog box appears, in which you show/hide the 
columns individually in the control column.

Toggle off an individual control columns:

The column is shown individually.

1. Right-click the symbol of the column to be hidden.  

2. Call up the "Hide column" function from the context menu.  

- or -

➜ Click on any icon of the column with the right mouse button.
Then click the icon of the column which you want to toggle off in the 
context menu.

With the "*" key of the keypad you enlarge the width of the control column.
With the "/" key of the keypad you reduce the width of the control column.

Some displayable data in the control column is only visible after technical 
editing.
Exception: The modules for the starts and picking-up after pressing-off that 
are selected when generating a new pattern.
25



4 M1 main program
4.4 Control columns
4.4.1 System

The data of this column has the column header .

The following functions are contained in the context menu of the column:

The following entries are displayed in the System column:

4.4.2 Comb, monitoring of fabric collection chamber

The data of the Comb column has the column header . The data of the 

Monitoring of fabric collection chamber column has the column header .

The following functions are contained in the context menu of the Comb 
column:

The following functions are contained in the context menu of the 
Monitoring of fabric collection chamber column:

Function Target

"S1" to "Sx" Assign system to the machine.

"S0" Assign empty stroke.

"Undetermined" Determine system automatically with technical editing.

Display Meaning

"S0" Empty stroke

"S1" to "Sx" Allocation of the technical rows to a system of the machine

Function Target

"Waiting position" Assign comb position in wait position.

"Top mm:" Assign top position of the comb in mm.

"Opening the comb hooks" Assign open comb hooks.

"Comb undefined" Determine comb position automatically.

Function Target

"LK1 monitoring of fabric 
collection chamber on"

Activate monitoring of fabric collection 
chamber.

"LK0 monitoring of fabric 
collection chamber off"

Deactivate monitoring of fabric collection 
chamber.

"Monitoring of fabric collection 
chamber undefined"

Determine monitoring of fabric collection 
chamber automatically.
26



M1 main program 4
Control columns 4.4
The following entries are displayed in the Comb column:

The following entries are displayed in the Monitoring of fabric collection 
chamber column:

4.4.3 Racking correction

The data of this column has the column header .

The "Technical Row data" dialog box is opened via the "Racking 
correction..." function in the context menu of the column.

You can enter the racking corrections in the "Technical row data" dialog 
box on the Racking tab.

Further information
Racking tab

4.4.4 Yarn carrier

The data of this column has the column header .

Right-clicking the column header opens the "Technical Row Data" dialog 
box.

The yarn carriers can be entered in the "Technical row data" dialog box of 
the Yarn carrier tab.

Display Meaning

"=-=" Comb moves into wait position below the needle bed.

"^x" Comb moves upwards to x mm below its top-most position for 
yarn insertion.

"|-|" The comb hooks can be opened before they are automatically 
opened upon reaching the main take-down.

Display Meaning

Monitoring of fabric collection chamber is activated.

Monitoring of fabric collection chamber is deactivated.
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4.4 Control columns
All data of the row will be displayed at the cursor when you move the 
cursor over the control columns.

Further information
Yarn carrier tab

4.4.5 Selection

The data of these columns has the column headers .

The whole rows are selected by selecting the fields in both of the control 
columns.

With the left control column all needle beds are selected. The front and 
rear needle beds and the additional beds can be selected separately in the 
technical view with the right-hand control column.

If you select the rows via the control columns a drawing attribute, e. g. 
color, is adopted to these rows immediately. If no drawing attribute is 
selected, the rows are selected only.
28



M1 main program 4
Yarn field view 4.5
4.5 Yarn field view
When the yarn field view is opened, the yarn fields and yarn carrier fields 
are automatically determined. Each yarn field is shown with its own color. 
The yarn fields are consecutively numbered from bottom to top and from 
left to right. If a yarn field is clicked in the Yarn field view, then it is also 
automatically selected in the Yarn field allocation  [see page 28] dialog 
box.
The allocation of the yarn fields to the yarn carrier fields can also be 
changed in this dialog box if necessary.

Yarn fields are also allocated by the M1 that are not used to determine the 
use of yarn carriers. These are required for technical editing and have a 
permanent designation (e.g. negative values).

This yarn carrier field can be opened as follows:

� "Yarn Fields" function in "Knitting Technique" menu  

� Symbol  of the "Pattern presentations" toolbar  

� "Yarn field allocation" button in the "Technical assistant" program

The Yarn field view and the "Yarn field allocation" dialog box are opened 
together.

When you run over the view with the mouse pointer you are provided with 
various information on the yarn fields on the status line, e.g. the yarn field 
number.

Navigating in the Yarn field view:

� You can scroll the display in the direction of the mouse pointer by 
pressing the "spacer" if the mouse pointer is within the Yarn field view.  

� Pressing the "x" key sets the displayed position of the Yarn field view in 
all other views.

Selecting in the Yarn field view:

� With "Ctrl"+"Shift", all yarn fields of a yarn carrier are selected.  

� If the "Ctrl" key is pressed during selection, the selection is added to an 
existing selection.
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4.5 Yarn field view
4.5.1 Context menu (yarn field view)
Some functions can also be called up via a context menu. Click on the yarn 
field view with the right mouse button.

The following functions are contained in the context menu of the yarn field 
view:

Some functions can also be called up via a context menu of the control 
column. Click on the control column of the yarn field view with the right 
mouse button.

The following functions are contained in the context menu of the control 
column in the yarn field view:

Function Target

Apply yarn carrier Apply yarn carrier.

Apply yarn field Apply yarn field.

New yarn carrier Assign new yarn carrier.

New yarn field Assign new yarn field.

Cursor/Default/Advanced Call up functions to select between 
different cursor types.

Cursor/Default/Simple

Cursor/Cross Hairs/Advanced

Cursor/Cross Hairs/Simple  

Cursor/Coordinate Display/
Advanced

Cursor/Coordinate Display/Simple  

Show Cursor Position in All Views/
Cursor

Save Settings Save window settings.

Function Target

Display/edit knitting sequence Open the Knitting sequence tab in the 
"Technical row data" dialog box.

Delete knitting sequence Delete created knitting sequence in a 
selected row.
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4.5.2 Yarn field allocation

This dialog box is opened with the icon  from the "pattern presentations" 
toolbar or with the "Yarn field allocation" button in the "Technical assistant" 
program. The Yarn field view window with the presentation of the yarn 
fields and the "Yarn field allocation" dialog box is opened. When the dialog 
box is opened, the yarn fields and the yarn carrier fields are automatically 
determined. You can, for example, change the assignment of the yarn 
fields to the yarn carrier fields and assign the yarn carrier fields a yarn 
carrier.

The dialog box can be moved. To do this, position the cursor in the dialog 
box and hold down the center mouse button. The dialog box is moved with 
the movement of the mouse.

Following technical editing the yarn carrier allocation can still be changed. 
On the other hand, color changes following technical editing result in an 
error message when the yarn field view is opened.

Make the following settings in this dialog box:

Element Meaning

Display window Display and select the yarn fields and the 
jacquards over the entire pattern width.

Knit-out section Select module for the binding and feeding 
and specify knitting-out direction.

Buttons for
No binding  

With a yarn field in which a binding is 
normally inserted, suppress binding.

Buttons for
Binding  

With a yarn field, with which no binding is 
made automatically, force binding.

Buttons for
Carriage direction  

Specify carriage direction for the first knitting 
row of the yarn field.

Knit-in section Selection of a module for the binding and 
feeding, specification of the knit-in direction.

Change yarn carrier fields 
section

Switch number of yarn carrier fields per yarn 
field and yarn carrier fields.

"Multi-system knitting" section Select arrangement of the rows on machines 
with several systems:
- "optimized"
- "even"

Swivel section Select carriage direction in which an intarsia 
yarn carrier is swiveled.
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4.5 Yarn field view
The buttons of the dialog box:

Change the setting in the dialog box and apply:

1. Select yarn field in the display window for which a setting is to be 
changed and applied.  

2. Change setting.  

3. Click the "OK" button.  

By selecting several yarn fields, the settings for these yarn fields can be 
changed at the same time. for this purpose, hold down the "Ctrl" or "Shift" 
key and select the desired yarn field in accordance with the Windows 
conventions. The active attributes of the selected yarn fields can now be 
changed simultaneously.

Further information
Yarn field view  [see page 26]
Pattern Presentation  [see page 54]

Type list field Select yarn carrier type for the selected yarn 
field.

Section
Yarn carrier correction left/
right

Specify yarn carrier correction for the left and 
right side for each yarn field and for the 
swiveled and non-swiveled states.

Cut section Specify SEN edge and time for clamping and 
cutting of the thread following knit-out.

Section
Settings according to sys. 
process

Select knitting cycle for a jacquard and 
specify system for the selected yarn field.

Open clamp section Specify number of rows after which the clamp 
of the yarn carrier is to be opened.

Yarn carrier allocation section Assign the yarn carrier fields with the 
undefined yarn carriers to the yarn carrier 
rails.

Button Function

"OK" Apply changes and close dialog box.

"Cancel" Close dialog box without applying changes.

" Initialize " The button is only available before technical editing. The yarn 
fields are recalculated, and therefore displayed with their 
original data. In addition, the yarn carrier specifications are 
accepted from the "Machine attributes" dialog box (Options tab).
Note: The yarn fields for an allocated Sintral function are also 
calculated.

Element Meaning
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4.6 Jacquard editor
The Jacquard editor is a window for the graphic input and display of the 
MC jacquard files <name>.jdv and <name>.jac.
The window has a control column on the left side, with the numbering of 
the picture rows (left) and the jacquard lines (right).

The dialog box can be moved. To do this, position the cursor in the dialog 
box and hold down the center mouse button. The dialog box is moved with 
the movement of the mouse.

The jacquard line number is used in the knitting program of the machine 
(Sintral) to allocate the corresponding jacquard line to the knitting 
command.

The following information is present in the title line of the window:

� Jacquard editor  

� Path and name of open file  

� Jacquard size with the width x height  

� * is shown when the edited jacquard has not yet been saved.

The jacquard can be edited with all available drawing tools and using the 
module technique. Selected areas can also be protected in the 
"Selections" menu. 
The jacquard is displayed with its jacquard colors (Color presentation) and 
additionally displayed jacquard symbols (Symbol presentation).
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4.6 Jacquard editor
To generate a new MC jacquard, use the New Jacquard Editor function in 
the "File" menu, and to open an existing MC jacquard use the Open 
function in the same menu. Select the corresponding file type in the "Open" 
dialog box that appears. 
The name of the window is Jacquard editor (module) when a module is 
open.

When you close the Jacquard editor (module), a window appears with a 
prompt asking if the module is to be saved in the database. If you answer 
this question with Yes, the module is saved in the module explorer in the 
"New modules" module group.

The numbering of the jacquard lines can be defined by specifying the 
values for starting line and step width which can be set. The setting is 
made in the New jacquard editor dialog box and in the Number rows dialog 
box.

The jacquard line numbers are displayed at the coordinate indicator at the 
cursor.

Further information
Extended (coordinate display)
Simple (coordinate display)  

4.6.1 Context menu (jacquard editor)
Some functions can also be called up via a context menu. Click on the 
jacquard editor with the right mouse button.

All functions in the context menu of the jacquard editor are identical to the 
functions of the same name in the "View/Options" menu.

Further information
Options
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4.7 Overview window
The Overview window is used for orientation and fast navigation in the 
pattern.
It is displayed or hidden with the "Overview" function in the "View" menu. 
The entire active pattern is shown in the open window. For this purpose it 
is reduced in size to a greater or lesser degree depending on the size of 
the Overview window. 
If the pattern in the window of the active view is not shown completely, 
then the overview window has a movable frame that enables navigation in 
the pattern. The larger the pattern, the smaller the displayed frame. 
The overview window has position memories with which various positions 
of the frame can be saved.

The display in the overview window matches the "Color Presentation" of 
the fabric view for a pattern or module. For a shape in the Shape editor the 
areas within shape and outside shape are shown. Existing selections are 
shown in the overview window.

Move navigation frame:

1. Click in the frame with the left mouse button.  

: Cursor shape within the navigation frame.

2. Drag the frame to the desired position with the left mouse button pres-
sed.  

3. Release left mouse button.  

The pattern section for this position is shown in the window of the 
active view.

With the  button an additional window section with the position 
memories of the overview window is displayed or hidden.
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4.7 Overview window
4.7.1 Context menu (overview window)
Some functions can also be called up via a context menu. Click on the 
position memory of the overview window with the right mouse button.

The following functions are contained in the context menu of the overview 
window:

Function Target

Delete All Saved Positions Delete entire position memory.

Adjust side ratio/Height Adjust height of overview window.

Adjust side ratio/Width Adjust width of overview window.

Adjustments Change number of displayed position 
memories.

Save Position Save current frame position.

Restore Position Set saved position in pattern.

Delete Buffer Delete position memory.
36



M1 main program 4
Overview window 4.7
4.7.2 Position memory
With the position memories up to nine different positions of the navigation 
frame can be saved. Saved positions enable extremely fast navigation with 
large patterns. 
The position memories are displayed or hidden with the  button. 

A memory space  consists of a display and a button. An empty 
memory is shown in gray. The number of memory spaces can be changed 
with the "Settings" function in the context menu of the overview window.

I. Save a position:

The position memory appears.

1. Move the navigation frame in the overview window to the desired 
position.
-> The pattern section for this position is shown in the window of the 
active view.  

2. Click on the button of a memory space with the left mouse button.
- or -
Select the "Save position" function in the context menu of the memory 
space.  

The position of the navigation frame is saved. The pattern section of 
this position is shown in the display of the memory space.

The saved positions are only available as long as the pattern is open.

II. Set a saved position in the pattern:

� The position memory appears.  
� At least one saved position exists.

1. Move the cursor into the memory space display.

-> The position is marked with a flashing symbol  in the overview 
window.  

2. Click on the left mouse button.
- or -
Select the "Restore position" function in the context menu of the 
memory space.  

The navigation frame is moved to the position of the memory space 
and the pattern section for this position is displayed in the window of 
the active view.
37



4 M1 main program
4.7 Overview window
Double-clicking the position memory with the left mouse button sets the 
pattern section for this position in all open windows.
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4.8 Menu bar (M1)
The menu bar is located at the upper edge of the M1 main window. M1 
functions are contained in the fold-out menus of this bar.

Fold out menu:

➜ Click on a name in the menu bar with the left mouse button.
The menu is folded out and the functions are visible for selection.

The function on which the mouse pointer is positioned is given a colored 
background and a brief description in the "Status line" toolbar. The function 
is run and the menu is closed again by clicking with the left mouse button.

If you do not want to start a function, then click on the name of the menu 
again or use the "SC" key on your keyboard to fold up the menu again.

The display in the menu bar is dependent on whether and which other 
windows are open. A picture icon before the name of the function means 
that this function is also contained in an Icon bar  [see page 53].

The following menus are contained in the M1 main program:

� File  [see page 35]  

� Edit  [see page 36]  

� View  [see page 38]  

� Selections  [see page 40]  

� Module  [see page 41]  

� Shape  [see page 44]  

� k&w Shape  

� Knitting Technique  [see page 46]  

� Sintral  [see page 48]  

� Tools  [see page 50]  

� Windows  [see page 52]  

� Question mark (?)  [see page 52]
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4.8.1 File
The following functions are contained in the "File" menu of the M1 main 
program:

Function Target

New Generate new pattern.

New jacquard editor Generate new MC jacquard.

Open Open saved pattern.

Close Module Explorer Close active window in module explorer.

Close Close active pattern.

Save Save active pattern.

Save as Save active pattern under another name.

Intermediate Backup Carry out manual data backup for the active 
pattern.

Load Intermediate Backup Open last manual data backup.

Import Call up functions to import picture, picture 
in paste buffer or modules.

Knit Memory Card Copy knitting program (Sintral) to or from 
the machine via external data carrier.

Global pattern parameters Call up global pattern parameters and 
configurations.

Properties Display pattern description for the active 
pattern.

Statistics Display specific details for the active 
pattern or selected area.

Last File/<file name> Open saved pattern via the file name.

End M1 Quit working with M1.
40



M1 main program 4
Menu bar (M1) 4.8
4.8.2 Edit
The following functions are contained in the "Edit" menu of the M1 main 
program:

Function Target

Undo Undo the last action.

Redo Restore the last undone action.

Cut Delete selected area in the pattern and 
simultaneously save it as a pattern 
element in the paste buffer.

Copy Save pattern element to paste buffer.

Paste Insert pattern element into the pattern.

Insert mirrored Insert pattern element in the pattern 
again at a mirrored position.

Delete Region  [see page 37] Remove selected area or columns or 
rows from the pattern.

Insert Region  [see page 38] Insert selected area or columns or rows 
into the pattern.

Delete rows Remove selected rows from the pattern.

Delete columns Remove selected columns from the 
pattern.

Insert row Increase pattern height.

Insert columns Increase pattern width.

Find & replace  [see page 38] Find needle actions and/or colors and 
replace or exchange them.

Replace starts Replace modules for start and/or picking-
up after pressing-off or short sleeve/short 
body.

1x1 Technique Distribute pattern to every 2nd needle.

Resort additional bed transfer Resort additional bed transfer if a pattern 
is converted from TC-R to TC4 or TC-T.

Mirror Entire Pattern Mirror module positions, modules and/or 
color of an entire pattern.

New line numbers (Jacquard 
editor)

Determine jacquard line numbering of 
machine jacquard.

Update line numbers (Jacquard 
editor)

Update jacquard line numbering of MC 
jacquard.

Group Selected Block to a Pattern 
Row

Group selected knitting rows to form a 
pattern row.

Separate Pattern Rows Dissolve knitting tows combined to form a 
pattern row.
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4.8.2.1 Delete Area...
This function is used to delete an area, columns or rows in the pattern.

I. Delete an area:

1. Select an area.  

2. Call up the "Delete area" function in the "Edit" menu.
- or -
Press "Del" key.  

The dialog box "Delete area" appears, in which you select whether the 
columns to the left or right of the deleted area are to be moved.

II. Delete columns or rows:

1. Select one or more columns or rows.  

2. Call up the "Delete area" function in the "Edit" menu.
- or -
Press "Del" key.  

The selected columns or rows are deleted immediately.

Insert Line for Limit Conditions Insert line for the limit conditions for 
generating a limit module.

Insert Line for Limit Module Insert lines for the limit module for 
generating a module with limit 
condition(s).

Gore Call up functions to edit gore.

Jacquards Edit jacquards present in the pattern.

Define Reference Row Define reference row for inserting a 
module in the fabric.

Function Target
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4.8.2.2 Insert Area...
This function is used to insert an area, columns or rows into the pattern.

I. Insert an area:

1. Select area.  

2. Call up the "Insert Area" function in the "Edit" menu.
- or -
Press the "Ins" key.  

The "Insert area" dialog box appears.

II. Insert columns or rows:

1. Select one or more columns or rows.  

2. Call up the "Insert Area" function in the "Edit" menu.
- or -
Press the "Ins" key.  

The dialog box "Insert columns <pattern name>" or "Insert rows 
<pattern name>" appears.

Further information
Insert Region  345_Bereich_einfuege:1312
Insert columns <pattern name>
Insert rows <pattern name>

4.8.2.3 Find Replace...
This function is used to search for and replace or exchange needle actions 
and/or colors in the selected area or in the entire pattern.

Find and replace colors:

➜ Run the "Find & Replace" function in the "Edit" menu.
- or -
Click the icon  from the "Drawing tools" toolbar.
The "Find & replace" dialog box, in which you search for and replace or 
exchange needle actions and/or colors, appears.

Further information
Find & replace (dialog box)
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4.8.3 View
The following functions are contained in the "View" menu of the M1 main 
program:

Function Target

Open Fabric View Open new fabric view.

Open Technical View Open new technical view.

Fabric View Before Technical Editing 
(cannot be changed)

Display the pattern original (before 
the first technical editing) in an 
unchangeable fabric view.

Technical View Before Technical 
Editing (cannot be changed)

Display the pattern original (before 
the first technical editing) in an 
unchangeable technical view.

Fabric View Before Technical Editing/
Check (cannot be changed)

Display the pattern (before the last 
technical editing) in an unchangeable 
fabric view.

Technical View Before Technical 
Editing/Check (cannot be changed)

Display the pattern (before the last 
technical editing) in an unchangeable 
technical view.

Use Fabric View Before k&w Shape 
(cannot be changed)

Display the pattern with the 
positioned shape (use before k&w 
shape) in a non-editable fabric view.

Use Technical View Before k&w 
Shape (cannot be changed)

Display the pattern with the 
positioned shape (use before k&w 
shape) in a non-editable technical 
view.

New view (jacquard editor) Open new view of MC jacquard.

Overview Display or hide overview window.

Screen Magnifier  [see page 39] Show screen magnifier.

Machine Explorer Open machine explorer.

Options Call up additional functions for 
pattern, module, shape and machine 
jacquard.

Toolbars Call up functions to display toolbars.
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4.8.3.1 Screen Magnifier
This function is used to show the "Screen magnifier" dialog box.

Show screen magnifier:

➜ Call up the "Screen magnifier" function in the "View" menu.
The "Screen magnifier" dialog box appears, in which you see the area 
around the cursor enlarged.

The enlarged area can be changed by changing the size of the "Screen 
magnifier" dialog box. Clicking the screen magnifier settings in the taskbar 
opens a dialog box in which you can make other settings. To hide the 
screen magnifier, close the dialog box.
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4.8.4 Selections
The following functions are contained in the "Selections" menu of the M1 
main program:

Function Target

Selection Call up functions to select with a drawing 
tool.

Search and Select Call up functions to search for and select 
the currently selected cursor functions or 
shape attributes in the pattern or selected 
area.

Select All Select all needle pairs of the pattern.

Cancel Selection Remove all selections contained in the 
pattern.

Center Selection Display selection(s) in the active window.

Select Partially Selected Modules 
Completely

Completely select modules that are only 
partially selected.

Deselect Partially Selected 
Modules

Deselect module that are not completely 
selected.

Invert Selection  [see page 41] Select unselected area.

Protecting selection Protect data of a needle position.

Cancel Protection from Selection Cancel protected area in a selection 
again.

All Areas Release all protected areas again.

Display protected areas Display and fade out protected areas.

Fill All Fill active cursor functions in an existing 
selection.

Clear Contents Delete an area in the pattern.

Frame Generate a colored frame around a 
selection.

Cancel Cursor Functions Switch off all cursor functions.

Adopt module/color/pattern 
parameters /
Apply Module and/or Color

Adopt module and/or color or pattern 
parameters as selection and continue 
working with it.

Accept Module Data from 
Selected Technical Rows

Adopt the module data from the selected 
area to the technical row data.

Identify and Select Module Identify and select modules in the pattern.

Turn Selections Rotate selections in the fabric view or in 
the jacquard editor.

Scale/Mirror Selections Change the size of or mirror selections in 
the fabric view or in the jacquard editor.
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A selection can be moved either while generating or at a later time. 
An existing selection can be increased or decreased in size.

Further information
Move selection
Select area

4.8.4.1 Invert Selection
This function is used to select the unselected area.

Select unselected area:

➜ Call up the "Invert Selections" function in the "Selections" menu.
The unselected area is selected. The original selection is canceled.

Turn Colors Rotate colors in the fabric view or in the 
jacquard editor.

Scale/Mirror Colors Scale or mirror colors in the fabric view or 
in the jacquard editor.

Turn Shape Information Rotate shape information in the shape 
view.

Scale Shape Information Scale shape information in the shape 
view.

Do Not Turn or Scale Anything Deactivate functions for rotating/scaling in 
the fabric view, in the jacquard editor or of 
the shape information in the shape view.

Function Target
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4.8.5 Module
The following functions are contained in the "Module" menu of the M1 main 
program:

Function Target

Module Explorer Open module explorer.

New module Generate new module.

New module (jacquard editor) Generate a new module in the Jacquard 
editor (module).

New Jacquard Module Generate a new jacquard module for 
generating jacquard areas.

Generate Modules from 
Selection

Generate new module from selection.

Generate Combination Module Generate new combination module with 
adjustable module distances.

Generate Step Module Generate a new module consisting of up to 
three individual modules (e.g. for binding-
off).

Generate Technical Container 
Module

Generate a new module consisting of 
several individual modules which can be 
selected for technical editing.

Generate Container Module 
Mirror

Generate a container module mirror with 
horizontally mirrored modules and modules 
for the back layer from an individual module 
for the front layer.

Generating k&w knitting cycle  
[see page 43]

Generate a new k&w knitting cycle module.

Import modules Import modules from an export file into the 
module database of the pattern 
workstation.

Select all modules  
[see page 43]

Select all modules in the current window of 
the Module explorer.

Switch over to 4 needle beds 
(TC-T/TC-R/TC4)

Insert additional beds / convert racking 
depending on the machine.

Switchover to 2 Needle Beds Remove the additional beds with a module.

Use the Latest Module Versions Replace older module versions in the 
pattern with a newer module version from 
the module database.

k&w pattern design auxiliary 
functions

Apply pattern design from front to back. 
Mirror back on vertical center axis.

Set back/front k&w column layer  
[see page 43]

Set back/front column layer.

Remove k&w column layer  
[see page 44]

Remove column layer.
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4.8.5.1 Generating k&w knitting cycle...
This function is used to generate a k&w knitting cycle.

Generate a knitting cycle in the knitting cycle editor:

1. Call up the "Generate k&w Knitting Cycle..." function in the "Module" 
menu.
-> The "Properties of <module name>" dialog box appears.  

2. Enter name of knitting cycle module and confirm the settings with the 
"OK" button.  

The knitting cycle editor is opened.

Further information
Knitting cycle editor  
Properties of: <module name/module group>

Always Insert Modules 
Relatively

Insert module with relative (instead of 
absolute) racking in the pattern.

Insert module: Resolve Racking 
Conflicts

Call up functions to resolve racking 
conflicts when inserting modules into the 
pattern.

Racking Priority in Modules Call up functions to determine the 
sequence of transfer rows if modules are 
inserted into the pattern one next to the 
other.

Insert Modules without 
Adjustment

Insert modules without observing the 
pattern rows.

Insert module without stitch 
length

Insert module without taking module stitch 
length into account.

Set connecting points Specify connection points for a module. 
The module is joined with the pattern at 
these connection points.

Localize the Pattern Modules Display module link of the pattern modules.

Function Target
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4.8.5.2 Select all modules
With this function, you select all modules in the current window of the 
Module explorer.

Select all modules:

➜ Call up the "Select All Modules" function in the "Module" menu.
- or -
Press the key combination "Ctrl" + "A".
All modules in the current window of the Module explorer and the 
module bar are selected.

Clicking the module bar with the right mouse button opens the context 
menu. This context menu contains the "Select all modules" function, with 
which you select all modules in the module bar.

4.8.5.3 Set back/front k&w column layer
This function is used to set the column layer with modules or pattern 
elements.

Set column layer:

➜ Call up the "Set k&w Front/Back Column Layer" function in the 
"Module" menu.
The column layer is set.

Further information
Remove k&w column layer  [see page 44]

4.8.5.4 Remove k&w column layer
This function is used to remove the column layer with modules or pattern 
elements.

Remove column layer:

➜ Call up the "Remove k&w Column Layer" function in the "Module" 
menu.
The column layer is removed.

Further information
Set back/front k&w column layer  [see page 43]
50



M1 main program 4
Menu bar (M1) 4.8
4.8.6 Shape
The following functions are contained in the "Shape" menu of the M1 main 
program:

Function Target

New (shr) Generate new shape.

Open (shr) Open saved shape.

Close Close active shape.

Save Shape Save active shape.

Save shape as Save shape of pattern under another 
name.

Move the shape Offset shape on the pattern in steps.

Generate/edit cutting shapes Generate/edit a shape with the shape 
editor.

Shape View Display or hide the shape view window

Shape attributes Open "Shape attributes" dialog box.

ShapeSizer  [see page 46] Open the ShapeSizer program.

Creating shape For a pattern without a shape, generate 
this shape in the shape view.

Open and position shape (shv, 
shp, shr)

Select cutting shape or shape and 
position it on the pattern.

Use shape (Cut, Fade out, 
Narrow)/(reinsert modules)

Join shape with the pattern or insert 
modified shape attributes.

Cut Delete the area outside the shape in the 
pattern.

Fade out Insert module for fading out from the 
shape edges in the pattern.

Undo Fade Out Remove fading out from the pattern 
again.

Use Narrowing Insert narrowing from the shape edges in 
the pattern.

Undo Narrowing Remove the narrowing inserted from the 
shape edges from the pattern.

Remove Shape/Cancel 
Positioning Shape

Remove shape in pattern or cancel "Open 
and Position Shape (shv, shp, shr)" 
function.

Add Missing Edges  [see page 45] Expand shape edges.

Conversion of shr -> shp  
[see page 45]

Convert open shr shape to shp shape and 
save.

No shape file/<shape file> Display any shape file present.
51



4 M1 main program
4.8 Menu bar (M1)
4.8.6.1 Add Missing Edges
With this function you can add missing shape edges.

Add shape edges:

The shape is opend in the shape editor.

➜ Call up the "Add missing edges" function in the "Shape" menu.
Missing shape edges will be added.

Shape Editor  [see page 20]

4.8.6.2 Conversion of shr -> shp
With this function, you convert the opened shr shape to a shp shape and 
save it.
If there are still no edge colors in the shr shape, they are automatically 
added during conversion.
If the shr shape consists of several neighboring shape parts, several 
individual shapes are generated by the conversion. The shape parts must 
each be separated by at least one column "outside the shape". The file 
names of the generated individual shapes are distinguished by 
consecutive numbering.

Convert shape:

➜ Call up the "Convert shr -> shp" function in the "Shape" menu.
The "Conversion of shr -> shp" dialog box appears, in which you can 
enter the stitch density and the unit of length for the conversion. 
Pressing the "OK" button converts the shape and you can save it with 
a name of your choice in the "Save as" dialog box.

4.8.6.3 ShapeSizer
Use this function to open the ShapeSizer program.

Open the ShapeSizer:

➜ Call up the "ShapeSizer" function in the "K&w Shape" or "Shape" 
menu.
The ShapeSizer window is opened.

Further information
ShapeSizer  
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4.8.7 Knitting Technique
The following functions are contained in the "Knitting technique" menu of 
the M1 main program:

Function Target

Configuration Display configuration in the pattern 
parameters.

Automatic Technical Editing Start automatic technical editing for the 
pattern.

Stepwise Technical Editing Open the Technical assistant to make 
settings or to start technical editing for the 
pattern.

Technical Editing of 2 Parts Start technical editing of two knitting parts 
per knitting zone for a pattern with a comb 
start.

Load Pattern Before Technical 
Editing

Open pattern original (before first 
technical editing).

Load technical editing 
intermediate backup  
[see page 47]

Load pattern as an intermediate backup 
during technical editing.

Undo Last Technical Editing 
(Check)

Remove data of last check after several 
technical edits from the pattern.

Log File Technical Editing Open the log for technical editing for the 
pattern.

Change machine/gauge Select new machine or gauge for the 
pattern.

Machine attributes Select machine attributes for the pattern.

Technical row data Call up functions to change yarn carrier, 
racking, holding-down jacks, carriage 
direction/system/stroke, fabric take-down, 
comb, STIXX, MS/PRINT, areas, knitting 
sequence or function calls.

Stitch length Allocate a stitch length to the pattern or 
module.

Fabric take-down Allocate a fabric take-down to the pattern 
or module.

Cycle Allocate a cycle to the pattern or module.

Carriage speed Allocate a carriage speed to the pattern or 
module.

Yarn fields Display yarn fields of the pattern.

Jacquard System Sequence 
Editor  

Open the "Jacquard System Sequence 
Editor" dialog box
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4.8.7.1 Load technical editing intermediate backup...

Restore the pattern to the state of one of the four intermediate backups 
during technical editing:

An intermediate backup was carried out for the active pattern during 
technical editing.

➜ Call up one of the functions "Load Technical Editing Intermediate 
Backup.../intermediate backup 1" to "intermediate backup 4" in the 
"Knitting Technique" menu.
The pattern is closed and opened again in the state of one of the 
intermediate backups.

4.8.7.2 Jacquard System Sequence Editor...
Call up this function to open the "Jacquard System Sequence Editor" 
dialog box.

Open the "Jacquard System Sequence Editor" dialog box:

➜ Call up the "Jacquard System Sequence Editor..." function in the 
"Knitting technique" menu.
The "Jacquard System Sequence Editor" dialog box appears where 
you can create system sequences of your own.

Further information
Jacquard System Sequence Editor (dialog box)  
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4.8.8 Sintral
The following functions are contained in the "Sintral" menu of the M1 main 
program:

Function Target

Sintral functions  [see page 49] Allocate Sintral functions to the pattern.

Generate Sintral / Jacquard / 
Setup

Generate knitting program (JAC/SIN/
SET) from the pattern.

Sintral check Test knitting program.

Save data in img file Save knitting program to the hard disk in 
a Cardimag.img file.

Save data to KMC Save the knitting program to the external 
data medium Knit Memory Card.

Save data to floppy disk Save knitting program to floppy disk.

Load data to machine Load knitting program to machine.

Import Sintral Check Import a knitting program of the SIRIX to 
the M1.

Import SETUP Import setup files to the M1.

Import SETUP from img file  
[see page 49]

Import setup data from img file to the M1.

Import SETUP from KMC  
[see page 49]

Import setup data from KMC to the M1.

Extract jac/sin/set files Extract knitting program (JAC/SIN/SET) 
from the pattern file.

Extract the set file  [see page 50] Extract the Setup data (SET) of the 
knitting program from the pattern file.

Display Sintral Display Sintral of the knitting program.

Display Jacquard Display jacquard of the knitting program 
(packed).

Display Jacquard Unpacked Display jacquard of the knitting program 
(unpacked).

Display SETUP Display setup data of the knitting 
program.

Generate sequence with  
[see page 49]

Generate sequence for T11 machines.

Sintral editor Start text editor for the knitting program 
files.
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4.8.8.1 Sintral Functions...
This function is used to assign Sintral functions to the pattern.

Open table of Sintral functions:

➜ Call up "Sintral Functions..." function in the "Sintral" menu.
- or -
Press the key combination "Ctrl" + "Alt" + "F".
The "Sintral functions" dialog box appears.

Further information
Sintral functions

4.8.8.2 Import SETUP from img-file...
This function is used to import data from a setup file saved in an img file.

Import data of the setup file:

➜ Run the "Import SETUP from img file" function in the "Sintral" menu.
The "Import setup from img file" dialog box appears. You can select the 
img file here.
You confirm the settings with the "Import" button.
You exit the dialog box with the "Cancel" button without applying the 
settings.

4.8.8.3 Import SETUP from KMC...
This function is used to import data from a setup file saved on a Knit 
Memory Card.

Import data of the setup file:

➜ Run the "Import SETUP from KMC" function in the "Sintral" menu.
The "Import setup from KMC" dialog box appears. You can select the 
file from the card index here.
You confirm the settings with the "OK" button.
You exit the dialog box with the "Cancel" button without applying the 
settings.

4.8.8.4 Generate sequence with...
This function is used to define a sequence for machines ST611, ST711 or 
ST811.

Define sequence:

➜ Call up the "Generate Sequence With" function in the "Sintral" menu.
The Sequence editor is opened, in which you define a sequence.

Further information
Sequence Editor
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4.8.8.5 Extract set file...
This function extracts the setup data (set) from the pattern file and save 
them as an individual file.

The function is available for a pattern without a knitting program if you have 
used the "Import SETUP" function in the "Sintral" menu.
During extraction a warning appears when outdated knitting program data 
is contained in the pattern. This is the case when the pattern has been 
changed after knitting program generation.
If the file name does not match the file name convention for knitting 
machines, then it will be automatically adjusted and a corresponding 
message displayed.

If no setup file is generated during extraction, then the following causes 
may be responsible:
- In the "Configuration" dialog box, Sintral tab, the Setup always in Sintral 
checkbox is activated.
- The machine selected for the pattern cannot process a setup file.

Extract the setup data from the active pattern:

The knitting program was generated for the active pattern.

➜ Run the "Extract set files..." function in the "Sintral" menu.
The "Extract set data" program is opened in which you specify the file 
name and select the directory.

The sin/jac/set files (or just a .set file) can be extracted from a .mdv file 
directly in Windows Explorer. The context menus "Extract_sin_jac_set" 
and "Extract_set" are available for this.

Further information
Import SETUP
Sintral tab
Extraction of Jac/Sin/Set data
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4.8.9 Tools
The following functions are contained in the "Tools" menu of the M1 main 
program:

Function Target

Modify Stitch Presentation Activate tools for modifying the module 
stitch display.

Reset Stitches Undo modified module stitch display.

Raise Stiches Optically raise module stitch display with 
color stepping.

Lower Stitches Optically lower module stitch display with 
color stepping.

Save Fabric View as Picture Save active fabric view as picture file.

Save fabric view as picture 
(section)

Save section of active fabric view as 
picture file.

Connect Logically Needle Actions 
on Needle Beds

Automatically interconnect the needle 
actions when drawing with needle actions 
in conjunction with the pencil drawing 
tool.

Save Jacquard as Image  
[see page 51]

Save the contents of the current jacquard 
view as a picture file.

Sequence Editor Starts the Sequence editor program to 
edit a sequence.

Sequence List Editor  
[see page 52]

Starts the sequence list editor program to 
edit a sequence list.

Order menu Starts the Order program.

Program Settings Make general settings for the M1.
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4.8.9.1 Save Jacquard as Image
With this function, the Jacquard view of the pattern or module is saved as a 
picture file in the bitmap or JPEG format so that you may, for example, 
print it out.

Save active jacquard view as picture:

➜ Call up the "Save Jacquard As Picture" function in the "Tools" menu.
The Windows default dialog box "Save file as" appears, in which the 
name and the directory in which the picture is saved are specified.

The saved picture corresponds to the current jacquard view. The 
maximum possible picture file size is 8192 x 8192 pixels. For picture files 
larger than 512 MB, a warning is displayed, as files of this kind cannot be 
edited with every software.

4.8.9.2 Sequence List Editor...
This function starts an editor independent of the M1 pattern workstation. In 
this editor you can open and edit sequential list files (SEL).

Start sequential list editor:

➜ Call up the "Sequential List Editor" function in the "Tools" menu.
The Sequential list editor is opened.

Further information
Sequence List Editor

4.8.10 Windows
The following functions are contained in the "Window" menu of the M1 
main program:

Function Target

Cascade Cascade windows.

Tile Horizontally Arrange windows next to each other.

Tiled Vertically Arrange windows in a column.

Arrange Symbols Arrange icons of minimized windows.

List of the open windows Make window active.
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4.8.11 Question mark (?)
The following functions are contained in the "?" menu of the M1 main 
program:

4.8.11.1 Sintral Pocket Card
This function is used to open the pocketcard with Sintral and direct 
commands for TC machines as online help.

Open Sintral pocketcard:

➜ Call up the "Show Pocketcard" function in the "?" menu.
The Sintral pocketcard is opened as online help.

Function Target

Help Topics Start online help.

Sintral pocketcard  
[see page 52]

Open pocketcard with Sintral and direct 
commands for TC machines as online help.

About STOLL M1 Display version number.
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4.9 Toolbars (M1)
The M1 main program has several toolbars. You can show and hide them 
in the "View/Toolbars" menu. A check appears in front of the function if the 
toolbar is displayed.

The following toolbars are contained in the M1 main program:

� Standard  [see page 53]  

� Pattern Presentation  [see page 54]  

� Zoom  [see page 56]  

� Drawing Tools  [see page 57]  

� Yarn Colors  [see page 59]  

� Module Colors  [see page 62]  

� Module Bar  [see page 66]  

� Needle Actions  [see page 68]  

� Layer Manager  [see page 71]  

� Multi-copy  [see page 73]  

� Comment Navigation  [see page 75]  

� Shape Tools  [see page 76]  

� k&w tools  

� Cycle line  [see page 79]  

� Status line  [see page 80]
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4.9.1 Standard
The M1 main program has a default toolbar, which you can position on the 
screen as desired. They can be displayed or hidden with the "Default" 
function in the "View/Toolbars" menu. A check appears in front of the 
function if the toolbar is activated.

Fig. 4-5 Default toolbar in M1 main program

The following symbols are contained in the default toolbar:

 Function Target

New Generate new pattern.

Open Open saved pattern.

Save Save active pattern.

Cut Delete a select area in the pattern and 
simultaneously save it as a pattern 
element in the paste buffer.

Copy Save a selected area as a pattern 
element to the paste buffer.
Without or with empty rows

Paste Insert a pattern element in the pattern.

Insert mirrored Insert a pattern element in the pattern 
at a mirrored position.

Generate Modules from 
Selection

Generate a module from the selected 
area in the pattern.
Without or with empty rows

Undo Undo the last action carried out.

Redo Redo the last undone action.

Context-sensitive help  
[see page 9]

Display the help on a topic.
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4.9.2 Pattern Presentation
The M1 main program has a pattern presentations toolbar, which you can 
position on the screen as desired. They can be displayed or hidden with 
the "Pattern Presentations" function in the "View/Toolbars" menu. A check 
appears in front of the function if the toolbar is activated.

Fig. 4-6 Pattern presentations toolbar in M1 main program

The following symbols are contained in the "pattern presentations" toolbar:

 Function Target

Yarn carrier Show and hide display bar for 
presentation of the yarn carrier 
paths.

Needle Actions Display and hide all needle 
actions.

Stitch length  [see page 55] Show and hide display bar for 
presentation of the stitch lengths.

Yarn field Display yarn fields of the active 
pattern.

Shape View Display the shape for a fully 
fashioned fabric.

Technical Row Display Display pattern with all technical 
rows.

Pattern Row Presentation Display pattern with pattern rows 
only.

Gore Presentation Display pattern with pattern rows 
only and display available gore 
areas folded up.

Insert module without 
adjustment

Activate/deactivate direct insertion 
mode.

k&w presentation with 
narrowing

k&w preview with narrowing and 
suspension.

k&w presentation k&w preview with suspension.
Note: Changes to the grading of 
the outer edges are only possible 
in the shape view if this 
presentation is selected.

k&w presentation collapsed k&w preview without suspension.
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4.9.2.1 Stitch length

With the icon  from the "Pattern presentations" toolbar you can display 
the display bars for the stitch lengths. The yarn carrier paths are already 
present for a pattern imported via the Sintral check data.

Displaying the stitch lengths:

The technical view must be active.

➜ Click on the icon  in the "Pattern presentations" toolbar.
-> A display bar in which the yarn carrier path is visible is displayed 
both above and below each technical row.

If you click on the icon  in the "Pattern presentations" toolbar, the display 
bars for the stitch lengths disappear again.

You can change the stitch length via the stitch length table in the context 
menu of the technical view.

Further information
Technical view  [see page 18]

4.9.3 Zoom
The M1 main program has a zoom toolbar, which you can position on the 
screen as desired. They can be displayed or hidden with the "Zoom" 
function in the "View/Toolbars" menu. A check appears in front of the 
function if the toolbar is activated.

Fig. 4-7 Zoom toolbar in M1 main program

The following elements are contained in the Zoom toolbar:

The display size of the pattern can be changed with the "Zoom" toolbar. 
You can select a zoom step directly or zoom the view in or out in steps. 
Zoom steps in which the fabric is completely visible are shown in red in the 
fabric view.

 Function Target

Setting the zoom step Set zoom step.

Large zoom step Increase zoom step.

Smaller zoom step Reduce step.
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I. Set the zoom step directly:

1. Click on the symbol  next to the zoom step display.
-> The list with zoom steps is opened.  

2. Select a zoom step.  

The zoom step is displayed in the list field. The display size of the 
pattern in the active window has been adjusted in accordance with the 
selected zoom step.

The aspect ratio can be adjusted in the fabric view. For this reason, two 
zoom levels are visible in the list field, where the first zoom level is for the 
needles and the second for the rows.

II. Change the zoom step in steps:

➜ Click on the  or  button to switch to the next higher or next lower 
zoom step.

To change the zoom quickly, you can also use the keys "+" and "-" on the 
number block.
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4.9.4 Drawing Tools
The M1 main program has a drawing tools toolbar, which you can position 
on the screen as desired. They can be displayed or hidden with the 
"Drawing Tools" function in the "View/Toolbars" menu. A check appears in 
front of the function if the toolbar is activated.

Fig. 4-8 Drawing tools toolbar in M1 main program

The following symbols are contained in the drawing tools toolbar:

 Function Target

Pencil Select a freehand line.

Line Select a straight line.

Rectangle/Square With a rectangle or a square, only select the 
border or the entire area.

Ellipse/Circle With a circle or an ellipse, only select the 
border or the entire area.

Polygon With a polygon, only select the border or 
the entire area.
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In the context menu of the toolbar the "Drawing with selection" function can 
be activated and deactivated. If the function is activated, the drawn area is 
automatically selected. If the function is deactivated, a previously available 
selection is retained.

Text as pattern element  
330_TextInMusterteil:13
30

Type in text and insert it as a pattern 
element into the pattern. 

Cancel Selection Remove all selections contained in the 
pattern.

Select All Select all needle pairs of the pattern.

Selection with the magic 
wand

Select adjacent needle pairs with the same 
properties.

Delete contents Delete an area in the pattern.

Fill up selections Fill active cursor functions in an existing 
selection.

Identify and Select 
Module

Identify and select modules in the pattern.

Find and select / In 
selected area

Find and select the currently selected 
cursor functions in the selected area.

Find and select / In 
entire pattern

Find and select the currently selected 
cursor functions in the entire pattern.

Find and select / In 
entire pattern (additive)

Find and select the currently selected 
cursor functions in the entire pattern. An 
existing selection is retained.

Find & replace  
[see page 38]

Search for needle actions and/or colors in 
the selected area or in the entire pattern 
and replace or exchange them.

Adopt modules/color/
pattern parameters

Adopt module and/or color or pattern 
parameters as selection and continue 
working with it.

Cancel Cursor Functions Switch off all cursor functions.

Toggle Move shape Change to the Open and Position Shape 
(shv, shp, shr) function in the editing mode.
Note: The button has no affect on the 
functions in the "Move shape" dialog box.

 Function Target
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The following actions can be carried out with the drawing tools:

� Select in the pattern  

� Drawing with cursor functions

Cursor functions are:

� Needle action  

� Module  

� Color  

� Stitch length  

� Shape attributes

The cursor functions can also be combined with each other.
Selection is described in the description of the symbols from this toolbar. 
Drawing with the cursor functions will be explained in the corresponding 
chapters on the needle actions, modules, colors and stitch length.

Further information
Move shape (dialog box)
Drawing with modules
Drawing with needle actions and/or color
Drawing with stitch length
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4.9.5 Yarn Colors
The M1 main program has a yarn colors toolbar, which you can position on 
the screen as desired. They can be displayed or hidden with the "Yarn 
Colors" function in the "View/Toolbars" menu. A check appears in front of 
the function if the toolbar is activated.

Fig. 4-9 Yarn colors toolbar in M1 main program

Each color in the "Yarn colors" toolbar represents a yarn. With these colors 
you can draw your new pattern. 
When the Jacquard editor or Jacquard editor (module) window is active, 
the appearance of the toolbar changes. Here various jacquard colors are 
available for the MC jacquard. Colors with the color number 1 to 40 also 
contain jacquard symbols. These can be displayed or hidden with the 
"Symbol presentation" function in the "View/Options" menu or in the 
context menu of the window.

Note that when saving as an MC jacquard <name>.jac all colors present in 
the picture with a color number that are greater than 40 are lost. In the text 
file these colors are saved as ?. When opened again, the color number 1 is 
shown for them. 
Save the picture as an MC jacquard <name>.mdv in the M1 format when 
you use colors with a color number > 40.

I. Selection of a color:

➜ Click on the desired color with the left mouse button.
The selected color is shown as a pressed symbol.
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II. Switch off colors:

Selecting a different color automatically switches off the color selected up 
to that point.

➜ Click on the symbol of the selected color with the left mouse button.
Now no color is selected.

III. Change the colors by, for example, generating a color palette with the 
colors of the season:

The color to be changed is selected.

1. Click on any color in the "Yarn colors" toolbar with the right mouse 
button.
-> The context menu appears.  

2. Select the "Change color" function from the context menu with the left 
mouse button.
-> The "Colors" dialog box appears in which a new color can be selec-
ted or a new color defined.  

With the "Get color from paste buffer" function from the context menu, 
three consecutive number with a maximum of three digits are searched for 
in the paste buffer. These are interpreted as RGB value sand allocated to 
the current color.

IV. Get color from the paste buffer:

� A color is selected in the toolbar.  
� There are RGB values in the paste buffer.

The RGB values must have been copied to the paste buffer with another 
program.

1. Click on any color in the "Yarn colors" toolbar with the right mouse 
button.
-> The context menu appears.  

2. Select the "Get color from paste buffer" function from the context menu 
with the left mouse button.  

The color selected in the toolbar contains the RGB values from the 
paste buffer.
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Several Color palettes are available to you in the context menu  
[see page 62] of the toolbar. With these you can quickly display the pattern 
in different colors.
Each Color palette has three color groups. The current color group can be 
seen in the list field.

If a jacquard area is located within the pattern and you move the mouse 
pointer over this area, then the colors of the jacquard are also shown in the 
"yarn colors" toolbar with a J.

Further information
Colors (dialog box)
Color palettes
Color groups

4.9.5.1 Context menu (yarn colors)
Some functions can also be called up via a context menu. Click on the yarn 
colors toolbar with the right mouse button.

The following functions are contained in the context menu of the yarn 
colors toolbar:

Further information
Create new color palette (dialog box)
Load color palette (dialog box)
Color palettes

Function Target

Create new color palette Call up the "Create new color palette" dialog box.

Load color palette Call up the "Load color palette" dialog box.

List of color palettes Select color palette.
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4.9.6 Module Colors
The M1 main program has a module color toolbar, which you can position 
on the screen as desired. They can be displayed or hidden with the 
"Module Colors" function in the "View/Toolbars" menu. A check appears in 
front of the function if the toolbar is activated.

Fig. 4-10 Module color toolbar in M1 main program

The following icons are contained in the module colors symbol bar for 
inserting the module into the edge area of the selection or for inserting the 
attributes of the module into the pattern:
  

 Function Target

Border free An imagined rectangle is laid around the existing 
selection. Starting from the lower left corner of 
this rectangle, an invisible grid is laid over the 
rectangle. The fields of the grid are the size of 
the selected module. The module is only filled in 
the fields that are located completely within the 
selection. The fields that are only located partially 
within the selection remain blank.
Note: Each disconnected selection is considered 
for you.

Border covered An imagined rectangle is laid around the existing 
selection. Starting from the lower left corner of 
this rectangle, an invisible grid is laid over the 
rectangle. The fields of the grid are the size of 
the selected module. The module is filled in the 
fields that are located in the selection. In contrast 
to edge free, the fields that are only partially 
found in the selection are also filled.
Note: Each disconnected selection is considered 
for you.
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Example: Cable module 2x2< is filled in a polygon (selected area):

Fig. 4-11 Cable module 2x2<

Edge exact An imagined rectangle is laid around the existing 
selection. Starting from the lower left corner of 
this rectangle, an invisible grid is laid over the 
rectangle. The fields of the grid are the size of 
the selected module. The module is filled in the 
fields that are located completely within the 
selection. In the fields that are only partially 
found in the selection, the modules are cut off so 
that they fit exactly in the selection. Transfer 
actions with receiving needles outside the 
selection are not cut off. Cursor functions that 
have the size of one needle pair are always filled 
up to the edge.
Note: All existing selections are considered as a 
continuous area.

Apply colors and 
needle actions

Insert the color of the module in the fabric 
together with the needle actions.

Apply needle 
actions only

The color within the fabric is retained.

Apply colors only Only the color from the module is inserted in the 
fabric.
The needle actions of the fabric are retained.

Insert Without Stitch 
Length

The stitch length of the pattern applies to the 
inserted module, not the preset stitch length of 
the module itself.

Insert a module with 
plating yarn

A module with plating yarn is selected.
You can allocate a different plating yarn to this 
plating yarn.

Data transfer in 
control columns

Data of the actual pattern element are 
transferred into the control columns.
Note: When the symbol is activated, the "Pattern 
element: Data transfer" dialog box appears. In 
this dialog box, you can select the data to be 
copied.

 Function Target
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Fig. 4-12 selected area

Fig. 4-13 Border free

Fig. 4-14 Border covered
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Fig. 4-15 Edge exact

With this toolbar you can specify how the modules are inserted in the edge 
area of the selection in the pattern, which module attributes are adopted in 
the pattern and which settings of the modules are applied during insertion 
under Apply.

If you want to insert a module with a module color other than the existing 
one into the fabric, then you do not need to change the module color in the 
module. It is sufficient to select the new color from the "Yarn colors" 
toolbar. This color is referred to as the editing color. It is framed in the 
toolbar with the module color.

  Module color

  Editing color

Select editing color with multicolor modules:

1. Click on the editing color in the "Yarn colors" toolbar.  

2. Select module.  

3. Click on the module color to be replaced with the editing color in the 
"Module colors" toolbar.  

The editing color is removed again with the "Reset all editing colors" 
function in the context menu for the "Module colors" toolbar. The context 
menu appears in which you click on any desired symbol of the toolbar with 
the right mouse button.
You can copy any desired area from the pattern to the paste buffer as a 
pattern element. The contents of the paste buffer is visible in the "Pattern 
elements" module group in the "Module bar". The pattern element is not 
automatically saved in the module database. During insertion from the 
Clipboard to the pattern, the contents of the Clipboard is considered a 
module and you can decide with the "Module colors" toolbar whether you 
want to insert only the needle action(s), only the color(s) or needle 
action(s) and color(s) in the pattern.
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4.9.7 Module Bar
The M1 main program has a module bar, which you can position on the 
screen as desired. They can be displayed or hidden with the "Module bar" 
function in the "View/Toolbars" menu. A check appears in front of the 
function if the toolbar is activated.

Fig. 4-16 Module bar in the M1 main program

The module groups with the modules of the open pattern can be selected 
in a list field.
The module links within the selected sub-group appear in the "Module 
bar".
If a module is selected, then the name of this module and an enlarged view 
of the module appears at the bottom edge of the toolbar. If you hold the 
mouse pointer on the picture, the size of the module appears in addition to 
the module name.

A module is selected by clicking on it with the left mouse button. The 
selection is deselected again when the module is clicked on again.
A selected module will be highlighted and displayed enlarged at the bottom 
of the module bar.

Double-clicking it opens a module for editing in the Module editor.

The properties of a module are displayed with "Alt" and a double-click.
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You can select and delete several modules in the module bar or module 
explorer.

� Pull a rectangle with the left mouse button pressed over the modules.  

� You can add further modules with the "CTRL" button and click on left 
mouse button.  

� Via the key combination "Ctrl"+"A" (selects all modules of the opened 
module group).

The following modules are shown in the "Module bar":

One local group <File name> is located in the module bar for each open 
Jacquard editor and Jacquard editor (module) window. The module 
generated from a selection is shown here. The modules are not saved with 
the jacquard file when the editors are closed.

Further information
Module Explorer
Pattern elements

Module group Note

"Pattern elements" Pattern elements saved in the User/<user name>/
pattern elements module group of the module 
database are displayed here.

"Favorites (Module Bar)" All module groups saved as sub groups to the 
"Favorites (module bar)" module group. These are 
displayed in the order from the module explorer.

"<Pattern name>
Pattern-local module 
group"

Modules of the active pattern The name of this 
module group appears in red in order to highlight it. 
You will find local modules and local pattern 
elements marked with a L in left upper edge within 
this group. 
If there is a number the upper right corner of the 
picture, this means that a newer version of this 
module is present in the module database. These 
can be replaced with the Use Latest Module 
Versions function in the "Module" menu.
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4.9.8 Needle Actions
The M1 main program has a needle-action toolbar, which you can position 
on the screen as desired. They can be displayed or hidden with the 
"Needle Actions" function in the "View/Toolbars" menu. A check appears in 
front of the function if the toolbar is activated.

Fig. 4-17 Needle-action toolbar in M1 main program

The following icons are contained in the needle-action toolbar:

 Function Target

Loop Insert needle actions without start 
conditions.

Tuck

Splitting

Transfer

Castoff

Loop sinking

Flottung

No needle action

Stitch with transfer Insert needle actions with start conditions.

Tuck with transfer

Float back

Float front

The needle is occupied Insert needle allocation for generating limit 
modules.

The needle is free

Do not check the needle 
allocation

Transparent position in 
the module

Insert transparent position in the module.

Cast off without 
dissolving stitches

Insert casting off without dropping stitches.

Optional transfer Insert transfer (optional).

Collecting optional 
transfer of k&w layers

Collect layers (optional).
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Needle actions can only be drawn in in the pattern in the Technical view. In 
contrast to the modules, no distinction is made between the front and rear 
stitch structure. You decide during drawing whether, for example, it 
becomes a front or back stitch by drawing in the stitch structure on the 
corresponding needle in the needle layout.

The symbol   Casting off without dropping stitches is drawn in in red in 
the technical view to ensure a distinction is made to the ordinary casting-
offs.

With the "Dissolve Drop Stitches" function in the context menu of the 
Fabric view you can display drop stitches in order to recognize errors in the 
pattern quickly.
With patterns for a machine with a comb, the entire fabric is cast off at the 
end of the pattern. If you now run the Dissolve drop stitches function, the 
entire fabric consists of drop stitches in the fabric view. To avoid this, you 
must use the Pressing off without dropping stitches needle action with 
these patterns for casting off the fabric at the end of the pattern.
In addition, this needle action is also used for plush.

When the icon   transferring (optional) is used, transferring is only 
carried out if the needle used for transferring is also to be allocated. This 
transfer is used with cable modules for k&w, for example. Before the cross-
over, the stitches of both layers must hang on one needle bed in this area.
With the Transfer icon  all needles yould always be transferred prior to 
cross-over, regardless of the needle allocation.
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Presentation in the technical view when using Transfer (optional):

The use of modules is preferable to the needle actions, as these are also 
provided with logic by limit modules, and therefore simplify knitting.

Further information
Generate limit module
Dissolve Drop Stitches

Presentation Meaning

The transfer (optional) is shown in the color pink with 
the sart condition level  switched off.

With the start condition level activated, the transfer 
(optional) is shown as Automatic transfer (with a 
light-blue background). For this purpose, the 
"Highlight Automatic Transfer" function in the 
context menu of the technical view must be 
activated.
Note: If you have drawn in a transfer (optional), 
however do not require this due to the needle 
allocation, then the light-blue background is shown, 
but not the transfer icon.
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4.9.9 Layer Manager

The M1 main program has a level manager toolbar, which you can position 
on the screen as desired. They can be displayed or hidden with the "Level 
Manager" function in the "View/Toolbars" menu. A check appears in front 
of the function if the toolbar is activated.

Fig. 4-18 Level manager toolbar in M1 main program

The following symbols are contained in the level manager toolbar:

 Function Target

Modification layer This level is first available during technical 
editing. Entries on this level (e.g. changed 
stitch length) cannot be covered by any 
other level.

Technical level Modules and needle-related pattern 
parameters (stitch length) required by 
technical editing are entered here.

Start condition level On this level the needle action transfer 
triggered by 
a needle action knitting with transferring,
a module with this needle action or
a module with limit conditions
is automatically entered.

Shape level If a Fully Fashion pattern is generated from 
a pattern, then the empty needle areas 
outside the shape are automatically 
entered here. 
Note: This level does not have a pattern 
without a shape. However, it becomes 
available and is displayed at a later time 
with the Generate shape function.

Shape module level If a Fully Fashion pattern is generated from 
a pattern, then the modules required for the 
shape are automatically entered here. 
Note: This level does not have a pattern 
without a shape. However, it becomes 
available at a later time with the Generate 
shape function.

Pattern level The most important level for pattern 
generation for the user. The modules for 
the start, for the basic pattern and for 
structures are arranged in it.
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With the toolbar, the levels of a pattern can be displayed or hidden 
individually in the fabric view or in the technical view.
The following applies to displayed levels (pressed symbol): Entries in the 
layer above overwrite those of the respective layer below.
The level used with the corresponding symbol is displayed in the status 
line for the needle position under the mouse pointer.
The status of the level (displayed or hidden) is saved on the pattern.

The levels have no meaning for row-related pattern parameters (fabric 
take-down and carriage speed). These parameters are visible and identical 
on all levels.
Entries on the modification level are not observed by technical editing 
when this level is hidden. All other hidden levels are observed and also 
displayed again for this purpose.

An editing action may not be visible when another level above the active 

editing level covers this action. For this position the cursor shape  is 
displayed and information is output in the status line. To make the edit 
action visible, the upper level must be deactivated.
Due to the editing action Delete contents (symbol ), the level below it 
becomes visible. If you use the Not (symbol ) needle action for deletion, 
then the level below it is not visible. 
During technical editing, the content of the level is transferred to the 
pattern level. Changes must be made to the pattern following technical 
editing on the pattern level.

Editing level The pattern, shape module or modification 
level is used as an editing level when the 
symbol is pressed. All subsequent actions 
are entered on the corresponding level. 
The symbol is not available when the level 
is not available or is hidden. 
A level must always be active as an editing 
level. In the default configuration the 
pattern level is activated as the editing level 
when a pattern is opened.

Edit within/outside shape The shape level is used as an editing level 
when the symbol is pressed. The level is 
also displayed, if it was hidden, and the 
shape tools within shape and outside 
shape become available. 
The symbol is not available when the level 
is not available or the Pattern row 
presentation is not activated. 
Note: On the shape level you can only use 
these two shape tools. For the other Shape 
tools  [see page 76] you must activate the 
Shape view.

 Function Target
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4.9.10 Multi-copy
The M1 main program has a Multi-Copy toolbar, which you can position on 
the screen as desired. They can be displayed or hidden with the "Multi-
Copy" function in the "View/Toolbars" menu. A check appears in front of 
the function if the toolbar is activated.

Multi-Copy toolbar in M1 main program

The following icons are contained in the Multi-Copy toolbar:

You can enter the distance for multiple drawing in of the modules in the 
input fields of the toolbar. The distance can also be set via two insertions of 
the module.

I. Draw module in by specifying the spacing several times in the pattern:

1. Click on the desired module in the "Module bar" or Module explorer.  

2. Activate icon  from the "Multi-Copy" toolbar.  

3. Specify the row distance after which the module is to be repeated in 
the editing field .  

If an entry is present in this field and no entry or 0 is in the editing field , 
then the module is only repeated vertically.

4. Specify the column distance after which the module is to be repeated 
in the editing field .  

If an entry is present in this field and no entry or 0 is in the editing field , 
then the module is only repeated horizontally.

5. Enter the number of repetitions in the editing field .  

 Function Target

Multi-copy Show/hide Multi-Copy.
Note: The function can be deactivated with 
the "Esc" key.

Row spacing Specify the row distance after which the 
module is to be repeated.

Column spacing Specify the column distance after which the 
module is to be repeated.

Repetitions Enter number of repetitions.
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You can specify the number of repetitions with the mouse. Therefore, it is 
not absolutely necessary to make an entry in this field.

6. Draw with the module in the fabric.  
The module is repeated with the spacing you specify starting from the 
position you click on in the fabric.

You can allocate the row distance, the column distance and the Direction 
for the repetition of the module directly to the module in the "Properties of: 
<Module name>" dialog box in the Cycles tab. In this case these values 
automatically appear after selecting the module. The values allocated 
directly to the module cannot be edited in the toolbar.

When a module with these properties is selected, the symbol  next to the 
editing field for the row distance changes to  and the symbol  next to the 
editing field for the column distance changes to the symbol  or  in 
accordance with the specified direction.

II. Draw module into the pattern several times with the mouse:

1. Click on the desired module in the "Module bar" or Module explorer.  

2. Activate icon  from the "Multi-Copy" toolbar.  

3. Place module echo in the desired position in the pattern and click the 
left mouse button once.
-> The module is inserted into the pattern.  

4. Move module echo relative to the initial position and click the left 
mouse button again.
-> The module is inserted again. The spacing is automatically entered 
in the input fields of the toolbar. The number of repetitions is automati-
cally set to 1.  

5. To insert additional copies of the module with the specified spacing, 
press the left mouse button again.
- or -
Move the last inserted copy with the right mouse button to change the 
spacing relative to the last insertion position.  

You can also change the spacing for multiple drawing in of the module via 
the arrow keys in the keypad of your keyboard.

Further information
Drawing with modules
Properties of: <Module name>.
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4.9.11 Comment Navigation
The M1 main program has a default toolbar, which you can position on the 
screen as desired. They can be displayed or hidden with the "Comment 
Navigation" function in the "View/Toolbars" menu. A check appears in front 
of the function if the toolbar is activated.

Fig. 4-19 Comment navigation toolbar in M1 main program

The following symbols are contained in the comment navigation toolbar:

Comments can be attached to any point within the pattern using the 
functions New comment (text), New comment (bitmap) and New comment 
(pin) in the context menu of the technical view or fabric view.
With the icons of the comment navigation toolbar you can switch between 
the comments. The current comment is shown with a red border.

The comments are switched between in accordance with the order of 
entry.

 Function Target

First comments Go to the first comment.

Previous comments Go to the previous comment.

Next comments Go to the next comment.

Last comments Go to the last comment.

Center current comments Center current comments.
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4.9.12 Shape Tools
The M1 main program has two different toolbars, shape tools for fully 
fashion and for k&w. You can position them on the screen as desired. They 
can be displayed or hidden with the "Shape Tools" function in the "View/
Toolbars" menu. A check appears in front of the function if the toolbar is 
activated.

Fig. 4-20 Shape tools toolbar for fully fashion and for k&w after cutting

Fig. 4-21 Shape tools toolbar for k&w before cutting

The following icons are contained in the shape tools toolbar for fully 
fashion and k&w after cutting:

 Function Target

Within shape Enlarge shape.

Outside shape Reduce shape.

Gore Enlarge gore area.

Delete gore Reduce gore area.

Suspend Enlarge area for interruption with k&w shapes.

Delete suspension Reduce area for interruption with k&w shapes.

Narrow/Widen Draw narrowing symbol in the shape edge.

Delete narrowing/
widening

Delete narrowing symbol in the shape edge.

Fade out Draw fade-out symbol in the shape edge.

Delete fade-out Delete fade-out symbol in the shape edge.

Separation Edit automatically generated separation.

Delete separation Delete separation.

Bind-off Draw binding-off symbol in the shape edge.

Delete binding-off Delete binding-off symbol in the shape edge.

Stitch length change Draw stitch length change symbol in the shape 
edge.

Delete stitch length 
change

Delete stitch length change symbol from the 
shape edge.

Separation of layers Draw in a separation between the front and back 
layer of a k&w shape row at the shape edge.

Delete separation of 
layer

Delete separation between the front and back 
layer of a k&w shape row at the shape edge.
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The Narrowing, Hide, Separation, Binding-Off and Stitch length change 
symbols are only active when a shape edge is selected.
For drawing you can use the tools from the "Drawing tools" toolbar.

When editing the shape, only the symbols that directly border on the shape 
edge are taken into account when connecting the shape to the pattern.
In the context menu of the shape view you can select a shape edge and/or 
display and hide individual symbols.

The following icons are contained in the shape tools toolbar for k&w before 
cutting out:

 Function Target

Within shape Modify form.

Gore Change gore area.

Suspend Change area for suspension.

Narrow/Widen Draw narrowing symbol in the shape 
edge.

Fade out Draw fade-out symbol in the shape 
edge.

Bind-off Draw binding-off symbol in the shape 
edge.

Stitch length change Draw stitch length change symbol in the 
shape edge.

Separation of layers Draw in a separation between the front 
and back layer of a shape row at the 
shape edge.

Multi-step narrowing  
[see page 78]

Draw in icon for multi-step narrowing 
based on specifications in "Narrowing 
M" dialog box.

Delete multi-step 
narrowing  [see page 78]

Draw in icon for multi-step narrowing 
based on specifications in "Delete 
narrowing M" dialog box.

Move lines Move shape row.

Selection Select area of shape edge.
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The icons Selection, Fixed step 2, Fixed step 4, Fixed step 6 and 

Automatic step with copied area are only active if the  button is selected 
for the pattern presentations. For Automatic step with copied area, a 
selected area must have been copied as well.

4.9.12.1 Multi-step narrowing/Delete multi-step narrowing

With the  and  icons you open the "Multi-step narrowing"/"Delete 
multi-step narrowing" dialog boxes, in which you make the settings for the 
multi-step narrowing.

Enter multi-step narrowing:

1. Click the  icon of the "Shape Tools" toolbar.
-> The "Narrowing M" dialog box appears.  

2. Select settings in the dialog box.
-> The presentation of the icon in the toolbar changes according to the 
settings in the dialog box.  

3. Draw in multi-step narrowing in the shape view.  

The markings in the shape view can be moved via drag & drop.

Fixed increments 1 to 6 Insert an increment every 1 to 6 
columns.

Automatic step with copied 
area

Insert copied area with automatic step 
repeated.

Use on both sides Execute additionally selected function 
to the left and right of the central axis 
symmetrically.

 Function Target
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Delete multi-step narrowing:

1. Click the  icon of the "Shape Tools" toolbar.
-> The "Delete narrowing M" dialog box appears.  

2. Select settings in the dialog box.
-> The presentation of the icon in the toolbar changes according to the 
settings in the dialog box.  

3. Draw in delete multi-step narrowing in the shape view.  

Further information
Narrowing M/Delete Narrowing M (dialog box)  

4.9.13 Cycle line
The M1 main program has a cycle line toolbar, which you can position on 
the screen as desired. They can be displayed or hidden with the "Cycle 
Line" function in the "View/Toolbars" menu. A check appears in front of the 
function if the toolbar is activated.

Fig. 4-22 Cycle line toolbar in M1 main program

The following symbols are contained in the cycle line toolbar:

The list of line types can contain a maximum of seven user-defined line 
types. A selected line type is deleted from the list with the "Del" key.
The line types are not pattern-specific and apply for the M1.

Further information
Edit cycle element

 Function Target

new Define new line type as drawing 
function.

 User-defined line After the size of the editing field is 
specified, the "Edit cycle element" 
dialog box is opened.
Note: The field can be expanded with 
the left mouse button pressed for 
specification of the size of the editing 
field.

Repetition factor Repeat factor of the new / user-defined 
line type
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4.9.14 Status line
The M1 main program has a status line at the bottom edge of the program 
window. They can be displayed or hidden with the "Status Line" function in 
the "View/Toolbars" menu. A check appears in front of the function if the 
toolbar is activated.

If the cursor is positioned on a function within the menu bar or on an icon of 
the toolbars, then a corresponding reference is shown in the status line at 
the far left.

The contents of the status line depend on the active view:

� Fabric view/Technical view  

� Display bars of the technical view  

� Yarn field view  

� Shape view/Shape editor  

� Jacquard editor

With the left mouse button pressed, information on the following functions 
is displayed:

� Selecting and drawing with modules  

� Change yarn carrier path
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4.10 Key combinations (M1)
With key combinations, also called key commands, hotkeys or shortcuts, 
you run frequently used functions in the M1 main program quickly and 
directly.

The following key combinations can be used in the M1 main program:

Key combination Function

"F1" Calling up help.

"F2" k&w shape / shape view or

shape / shape view

"F3" Module / Module-Explorer

"F4" Knitting technique / yarn fields

"F5" Toolbar drawing tools / Pipette / Apply module and 
color

"F6" Toolbar drawing tools / Pipette / Apply color or 
pattern parameter

"F6" (shape view) Select the shape edge to which the cursor is 
pointing in the shape attribute table.

The cursor is located on a position with a edge 
color: The edge color is picked-up.

The cursor is located on a position without a edge 
color: Within shape or Outside shape is picked-up.

"F7" Selections/Cancel selections

"F8" Edit/Group a selection block to a pattern row

"F9" Knitting technique/Technical row data

"F10" Knitting technique/Automatic technical editing

"F11" Generate Sintral / Sintral / Jacquard / Setup

"F12" File/Save as

 

"," (Comma) View / Options / Cursor / Coordinate display / 
Advanced

"." (period) View / Options / Cursor / Show cursor position in 
all views

"L" Edit / Gore / Close Gore Element

"X" Synchronizing views.

 

"Ctrl"+"F2" View/Overview

"Ctrl"+"F3" Edit/Jacquards

"Ctrl"+"F4" Close the current window.

"Ctrl"+"F5" View/Options/Technical row presentation
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"Ctrl"+"F6" View/Options/Pattern row presentation

"Ctrl"+"F7" View/Options/Gore presentation

"Ctrl"+"F8" Edit/Separate pattern rows

"Ctrl"+"F9" Call up pattern parameter tables.

"Ctrl"+"F10" Knitting technique/Stepwise technical editing

"Ctrl"+"F11" Sintral/Sintral check

"Ctrl"+"F12" File/Close

 

"Ctrl"+"A" Selections/Select all

"Ctrl"+"B" Selections / Center selection

"Ctrl"+"C" Edit/Copy

"Ctrl"+"F" Selections/Find and select/In entire pattern

"Ctrl"+"I" Edit / Paste Mirrored

"Ctrl"+"L" Knitting technique/Stitch length

"Ctrl"+"M" Module/New module

"Ctrl"+"N" File/New

"Ctrl"+"O" File/Open

"Ctrl"+"R" Knitting technique/Cycle

"Ctrl"+"S" File/Save

"Ctrl"+"V" Edit/Paste

"Ctrl"+"W" Knitting technique/Fabric take-down

"Ctrl"+"X" Edit/Cut

"Ctrl"+"Y" Edit / Redo

"Ctrl"+"Z" Edit/Undo

 

"Shift"+"F2" Toolbar module colors / Apply colors and needle 
actions

"Shift"+"F3" Toolbar module colors / Apply needle actions only

"Shift"+"F4" Toolbar module colors / Apply colors only

"Shift"+"F5" View/Options/Fabric presentation

"Shift"+"F6" View/Options/Symbol presentation

"Shift"+"F7" View/Options/Color presentation

"Shift"+"F8" View/Options/Module color presentation

"Shift"+"F9" Knitting technique/Configuration

"Shift"+"F10" Knitting technique / Load Pattern Before Technical 
Editing

Key combination Function
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"Shift"+"F11" k&w shape / Generate/Edit Shape or

Shape/Generate/edit shapes

"Shift"+"F12" View/Options/Display additional beds

 

"Shift"+"1" Edit / Define Reference Row

 

"Alt"+"F2" Shape / Open and Position Shape

"Alt"+"F3" File/Import/Modules

"Alt"+"F4" File / Exit M1

"Alt"+"F5" Selections/Fill up

"Alt"+"F6" View / Options / Rear View

"Alt"+"F9" File/Import/Picture

"Alt"+"F10" Sintral/Display Sintral

"Alt"+"F11" Sintral/Import Sintral check

"Alt"+"F12" Sintral/Import SETUP

 

"Ctrl"+"Shift"+"F11" k&w shape / Put Together k&w Shape

Shape / Put Together k&w Shape

 

"Ctrl"+"Shift"+"F" Selections/Find and select/In entire pattern 
(additive)

"Ctrl"+"Shift"+"M" Module/Generate a module from selection

"Ctrl"+"Shift"+"S" Edit / Gore / Define Gore

 

"Ctrl"+"Alt"+"A" Module / Set Connection Points

"Ctrl"+"Alt"+"B" Display selection in the center of the window.
The zoom level will be kept

"Ctrl"+"Alt"+"F" Sintral/Sintral functions

"Ctrl"+"Alt"+"L" View / Options / Stitch Lengths as Needle Action 
Background

"Ctrl"+"Alt"+"M" View/Options/Display module limits

"Ctrl"+"Alt"+"S" View/Options/Save settings

"Ctrl"+"Alt"+"V" Knitting technique/Carriage speed

 

"Delete" Edit/Delete rows

"Delete" Edit/Delete columns

"Insert" Edit/Insert row

Key combination Function
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"Insert" Edit/Insert column

"Esc" Selections/Cancel cursor functions

 

"+" (number block) Toolbar zoom / Greater Zoom Step

"-" (number block) Toolbar zoom / Smaller Zoom Step

"*" (number block) Increase width of the control columns.

"/" (number block) Decrease width of the control columns.

"5" (number block) with 
the "Num" key active

Position shape in the middle.

Key combination Function
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Term Explanation

Application The knotting of selected areas within a fabric piece results in a fabric within the 
fabric. Example: Knit-on pocket in a front.

Automatic transfer An automatic transfer is a transfer that does not need to be drawn by the user, 
but is instead entered automatically. This transfer takes place on the starting 
condition level.

Auxiliary take-down The auxiliary take-down grasps the fabric directly under the needle bed, and 
therefore supports stitch formation. As a result, all fabric-typical requirements, 
including those of fully fashion knitting, can easily be carried out.

Base line (Shape editor) The base line is the horizontal coordinate axis in the Shape editor. In contrast to 
the vertical coordinate axis (center axis) this is not displayed. In general the start 
line of the shape lies on the base line.

Basic Modules for new patterns The pattern referred to as a basic pattern is the pattern generated in the "New 
pattern" dialog box after start-up. This basic pattern of back stitch forms the 
basis for the generation of a new pattern.

Border The stitches on the fabric border.

Cams Movable cams screwed onto the cam plates form cam trucks that move the 
needles. They are referred to as a knitting system. Raising and take-down cams 
are movable. Take-down cams control the stitch tension and are positioned by 
the knitting program with a step motor. The raising cams control the needles in 
accordance with the pattern in the different cam trucks for knitting and transfer.

Carriage assembly The carriage assembly is driven by the drive motor via a toothed belt and runs 
on a front and back carriage guide rail, which covers the entire length of the 
machine. The operating path of the carriage assembly is controlled by the knit-
ting program.

Carriage bow The carriage bows connect the front and back carriage part.

Carriage direction Direction (left or right) in which the carriage moves.

Carriage part One front and back carriage part each form a unit together with the carriage 
bows and the yarn change device. The carriage parts carry the cam plates with 
the knitting units, consisting of a knitting system, selection system and step 
motor. Each knitting unit in the front carriage box is allocated an identical knitting 
unit in the back knitting box.

Carriage stroke The movement of the carriage assembly in any direction to the left or right.

Center racking Consecutive transfer rows with different racking are, where possible, grouped to 
form one stroke.

Checking Technical editing for a pattern for which technical editing has already been car-
ried out. Here later changes to the pattern are checked for errors and missing 
data added.
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CMS pattern memory The CMS knitting programs are saved as SINTRAL programs in the pattern 
memory of the CMS computer. The SINTRAL command PA: establishes as knit-
ting pattern from individual jacquard pictures.
Example:
PA:20. 5JA1 20. means: 20 needles for basic color - 5 x jacquard motif 1 - 20 
needles for basic color.

Color With the M1 colors are used to represent different yarns and to allocate pattern 
parameters. With the colors for the yarns a distinction is made between the yarn 
color, module color and editing color.

Color adjustment When modules are inserted in the pattern, it is checked whether the color of the 
stitch row from the module is also present in the pattern row of the pattern. If this 
is the case, the stitch row from the module is positioned on the stitch row with 
the same color in the pattern. This procedure is called color adjustment.

Color groups Within a color scheme there are the three color groups standard, 1:2 multi 
gauge and technical. The color palette of the color groups standard and 1:2 
multi gauge are identical, however these have different yarn numbers for diffe-
rentiation. The colors from the standard color group are used for drawing color 
areas within a pattern. The color group 1:2 multi gauge is used to generate multi 
gauge patterns. Based on the yarn number it is recognized that a multi gauge is 
concerned and a correct presentation can take place in the fabric view. The 
colors for the separation rows and the start are contained in the technical color 
group. A yarn type is also specified for these.

Color jacquard With color jacquard motifs of colored stitches are knit with the needle selection 
in the knitting systems and with different colored threads allocated to the indivi-
dual knitting systems.

Color reduction When a picture with more than 16 colors is imported, the number of colors is 
automatically reduced to a maximum of 16 colors, whereby similar colors are 
combined. The remaining colors can then be further reduced as desired.

Color scheme Color schemes are present for viewing a fabric in different color compositions. A 
color scheme is a color palette that you can put together. Each color scheme 
contains the three color groups standard, 1:2 multi gauge and technical.

Column The vertical arrangement of the stitches relative to each other is called a column 
(wales).

Comb take-down With the comb take-down the fabric pieces are automatically begun on empty 
needles, cast off after completion and laid in the collecting area of the CMS. For 
this purpose, a net course whose stitches are grasped by the comb hooks is 
knitted. The fabric that follows is automatically guided into the fabric take-down.

Combination module A combination module consists of up to 9 existent modules and can be inserted 
in the fabric with a variable width and height.

Comments In the M1 Pattern Workstation comments in the form of text can be defined for 
an exact position in the fabric and in the technical view of the pattern. In addi-
tion, it is possible in the fabric view to attach a pin or a bitmap file to any desired 
position.

Comments CMS knitting programs consist of SINTRAL commands and comment lines. The 
designer or knitter uses comments to explain SINTRAL commands or provide 
additional information. Example: The yarn carriers used in the fabric and the 
yarn color required for the design, or the code number of the design. Comment 
instructions are ignored by the machine during production. Comments are only 
intended for the operator. Comment lines begin after the line number with a "C".
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Connection points A connection point is defined with one row knitting into and one row knitting out 
of the module. It therefore designates the points at which the module is connec-
ted to the pattern. For the rows lying between those points the yarn carrier 
moves within the module.

Container files Container files are files in the STOLL Knit Memory Card Format, however on 
common data carriers (hard disk, floppy disk, CD or DVD). They have the 
default file name extension .IMG. In particular, container files are saved on 
floppy disks for data exchange with the knitting machines and pattern prepara-
tion units. These files are created and managed with the program STOLL Knit 
Memory Card.

Context menu Functions are available in a context menu that refer especially to a certain area 
of the graphic interface. Context menus are opened with the right mouse button.

Context-sensitive help The context-sensitive help enables the M1 Online Help on a specific topic to be 
opened directly. Descriptions of all commands, symbols and views of the M1 
interface can be displayed.

Counter-gore Completion of a gore in order, for example, to obtain a straight fabric again after 
a wedge-shaped gore.

Coupling width Spacing of the carriages in the Tandem mode (e.g. 50, 52, 54 inches). The cou-
pling width is specified by the manner of installation of the coupling rod.

CPU Central Processing Unit

Cursor functions The functions needle action, module, color, stitch length and the shape attribu-
tes are cursor functions. When they are activated, they "hang" on the cursor and 
can therefore be used for drawing.

Cycle A cycle is a repetition of rows or columns.

Cycle switch (RS) In the SINTRAL program knitting rows can be set up and repeated as a cycle, 
e.g. as a pattern cycle. A cycle begins with RBEG and ends with REND. 19 
cycle switches(RS1 - RS19) can be set to 1 - 9999 cycle repetitions each. This 
means that the number in the cycle switch determines the number of repetitions.

Database All modules, the Stoll machines and the customer machines are stored in the 
database. The database with the modules is called the module database and 
the database with the machines the machine database.

Desktop software On the graphically oriented user interface of the CMS touch screen all machine 
functions are accessed and the CMS operating data are displayed. The user 
interface shows information on the current operating situation in the process.

Dialog box A window in which information is entered or selected that is required by the pro-
gram for carrying out actions.

Direct insertion With direct insertion, the module is not automatically sorted into the existing knit-
ting rows of the pattern. Row adjustment does not occur. Knitting cycles are 
inserted independent of pattern rows in the module or pattern.

Direct selection A knitting specification for needle selection (SINTRAL command), a maximum of 
64 needles wide, over the entire fabric piece.
D = Direct selection of needles over the entire machine width
I = Needle selected (knitting)
. = Needle not selected (non-knitting)
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Display bar For the following knitting row data or pattern parameters you can display a dis-
play bar in the technical view: Yarn carrier path, holding-down jacks, stitch 
length, fabric take-down and carriage speed. The display bar is shown below the 
knitting row for the front needle bed and above the knitting row for the back 
needle bed. Colors are shown in the display bar that are allocated the individual 
values.

Domain A group of interconnected computers share data and resources.

Drag & Drop Manner of working for copying elements (drag) and inserting them again at the 
desired location (drop).

Editing color If you want to insert a module with a color other than the existing one into the 
fabric, then you do not need to change the module color in the module. It is suf-
ficient to select the new color from the Yarn colors toolbar. This color is referred 
to as the editing color.

Empty row A traverse of the carriage assembly during which all knitting systems and yarn 
carriers are inoperative. This is required in exceptional cases.

Fabric pattern A small section of the fabric produced for visual, gripping, reference and quality 
inspections.

Fabric piece A fabric area that is knit in the desired making-up size, for example a front, back 
or sleeve.

Fabric take-down This is located under the needle beds and depending on the CMS type consists 
of the three units: Main take-down, auxiliary take-down and comb take-down. 
The main take-down, two rubber-coated rollers, is driven by an electronically 
controlled motor. The auxiliary take-down grasps the fabric directly under the 
needle beds. With both the take-down force and the take-down speed are pro-
grammable. With the comb take-down fabric pieces are automatically begun, 
guided into the main take-down and cast off following completion.

Fabric view Graphic 3D presentation of the pattern.

Fade out A shape may have the "Hide" icon in one or several shape edges. If the shape is 
linked to the pattern, then the module allocated to the "Hide" icon for the shape 
attributes is inserted in the pattern.

Favorites The modules in the "Favorites" module group are shown in the "Module bar".

Favorites Linking to preferred files, directories or websites.

FTD (fabric take-down) The motor-driven fabric take-down holds the fabric at the desired tension. The 
fabric take-down value can be adjusted with the knitting program.

Fully fashion knitting Fabric pieces, for example front pieces or even entire sweaters, can be produ-
ced as cut goods or as fully fashion fabric. Fully fashion fabrics result by wide-
ning or narrowing stitches at the fabric edge. Cutting work is unnecessary with 
fully fashion knitting, and less yarn is required. A more valued overall appea-
rance of the clothing item is achieved as well. Fully fashion knitting is possible 
on all CMS machine models.

Fully fashion knitting with 
casting off (shaping)

Production of a nearly fully fashion knitted piece (shaping, not fully fashion). In 
place of narrowing (fixed selvedge stitches), stitch areas are cast off (open sel-
vedge stitches) to save time and yarn during the knitting process. However, with 
fully fashion knitting considerably more yarn is saved.
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Function A command that can be used in the SINTRAL knitting program with which 
several knitting lines can be grouped to form a unit. The beginning of the 
function is marked with FBEG and the end of the function with FEND. The 
function is given a name, e.g. F:2x1 for a 2x1 start. Functions simplify the knit-
ting programs.

Gore A gore is understood to be the knitting of additional fabric areas (knitting rows, 
often wedge-shaped). The gore consists of gore segments. These are knitted 
consecutively.

Gore function Automatic generation of the knitting zones (gore segments) of a gore. A tool for 
this purpose is contained in the gore presentation of the technical view.

Gore Presentation Presentation form in the Fabric and Technical view with which the knitting rows 
of a gore are pulled together.

Gore preview Graphic display of the results to be expected within the gore function.

Gore segment A gore segment is a contiguous knitting zone in which the knitting width changes 
(becomes larger or smaller) in each knitting row. At least two consecutively knit 
knitting segments result in a gore.

Gore segment line Tool in the gore function for defining the gore segments.

Grouping You can group (combine) several technical rows to form a pattern row. With 
intarsia and jacquard the grouping is generated automatically. With these Stoll 
modules it is already specified.

Hardware profile Describes hardware configuration and properties

Held stitch This results when a needle holding a stitch does not knit. If several stitch rows of 
this kind follow consecutively, then this stitch will be stretched increasingly. This 
technique opens up various pattern design possibilities, such as knop patterns, 
wave patterns etc.

Holding-down technology Swiveling holding-down jacks hold down the fabric (holding-down position) on 
the knock-over edges of the two CMS needle beds when the needles are driven 
out for stitch formation. The holding-down jacks are open during thread inser-
tion. Control is automatic.
The CMS holding-down technology (STOLL patent) enables unusual patterns, 
multi-dimensional knitting (fabric on fabric) and the production of "technical texti-
les".

img file The knitting program (Sintral) and/or machine and order data can be saved to 
the hard disk, a floppy disk or a Knit Memory Card in a Cardimag.img file. A TC 
knitting machine that is networked via Ethernet and configured accordingly can, 
for example, directly access a Cardimag.img file on the hard disk.

Intarsia pattern Color pattern, whereby the colored pattern threads are not knit through the 
entire fabric. Usually medallion-like or geometric designs including with a struc-
ture.

Intarsia yarn carrier Swiveling yarn carriers used for the production of intarsia fabrics.

Jacquard Term for pattern selection named after its inventor Jacquard.
Today: Knitting with needles selected in accordance with the pattern. Also a pat-
tern designation, for example 3-color jacquard: Knitting of jacquard motifs (pic-
tures) using knitting yarns in 3 different colors. Or structure jacquard, transfer 
jacquard etc.
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Jacquard color 256 different jacquard colors are available for the MC jacquard in the jacquard 
editor. The colors with the color numbers 1 to 40 contain additional jacquard 
symbols required in the text file of the MC jacquard (*.jac) for the machine knit-
ting program.

Jacquard editor Image editor for the MC jacquard. This can be generated using the module tech-
nique and saved for the M1 (*.jdv) or for the machine (*.jac).

Jacquard editor (module) Image editor for modules that can be used in the MC jacquard.

Jacquard generators To generate a jacquard from a color area in the pattern, a jacquard generator (or 
a jacquard module) is allocated to this area using a dialog box. Jacquard gene-
rators determine the structure of the reverse side such as float, stripe, twill and 
net.

Jacquard group A jacquard group consists of the yarn fields of a jacquard that was generated 
with a jacquard generator or a jacquard module. The jacquard groups are dis-
played in the yarn field view. As a result it can quickly be seen where a jacquard 
is located in the pattern.

JDV module These are modules for the jacquard editor that only consist of jacquard colors 
and can only be used in the MC jacquard files.

JSA (Jacquard Structure Auto-
matic)

JSA from STOLL enables knitting pattern and knitting program generation with a 
high level of automation. The user draws the design to be knit directly on the 
screen. The STOLL pattern workstation SIRIX then automatically generates the 
knitting program from it for any electronic Stoll flat knitting machine. With this 
programming technique the specifications for the control and jacquard section 
are combined in one jacquard line. JSA is also equipped with functions and 
modules such as binding-off, knitting cables, knitting aran patterns and inserting 
trimming and pockets.

k&w Shape A k&w shape consists of closed lines for the body and sleeve that represent an 
entire article when interconnected.

knit and wear (k&w) A k&w machine produces fully fashion complete articles. The fabrics come out 
of the machine ready to wear with a fixed start, closed body, knitted-on arms and 
a knitted in neck welt. This eliminates the need for fabrication in the sewing 
shop.

Knit Memory Card (KMC) The Knit Memory Card is a powerful storage medium for the exchange of pattern 
data from the pattern workstation to the machine or from machine to machine. 
The STOLL Knit Memory Card Adapter is required for reading and writing Knit 
Memory Cards (KMC).

Knit Memory Card Adapter The STOLL Knit Memory Card Adapter is required for reading and writing Knit 
Memory Cards (KMC). This device is connected to a serial port on the computer 
and addressed via the name of the port.

Knitting program Instructions with knitting information for controlling (computer) the Stoll flat knit-
ting machines. Knitting information concern, for example, yarn carriers, fabric 
take-down, stitch tension, machine speed etc. The machine uses the SINTRAL 
programming language developed by STOLL, which is based on the BASIC pro-
gramming language.
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Knitting row/stitch row During knitting each knitting system generates a horizontal stitch row during 
each stroke to the left or right. A yarn carrier running with each knitting system 
lays the thread in the needles for stitch formation in the process. A machine with 
3 knitting systems knits 3 stitch rows per stroke. The number of stitch rows knit 
in one stroke corresponds to the number of working knitting systems and yarn 
carriers. With color jacquard, for example for a three-color jacquard pattern, 3 
knitting systems product one stitch row per stroke on the pattern side of the 
fabric, which consists of three knit color stitch rows.

Knitting system In each carriage assembly 1, 2, 3 or 4 knitting systems each are housed at the 
front and back. The knitting system, selection system and step motor form a 
unit. 
Electronic selection systems with two selection points each select the needles 
for knitting, tuck, three-way technique, splitting, transfer and receiving. 
With a step motor the take-down cams control the stitch tension by pulling in 
more or less knitting yarn during loop sinking with the needle hooks, forming 
loose or tight stitches in this way.

LAN (local area network) Local network

Levels of a pattern A pattern written in the M1 consists of layered levels. The top level overwrites 
the respective level below it. The layers can be displayed or hidden individually.
There are editing levels for the user and special levels for the automatic 
functions in which these enter their results.
Advantages of the level structure:
- The automatic functions of the M1 can be switched off by the user during pat-
tern generation and then on again later.
- Fully Fashion patterns can be split apart in the basic pattern and the shape
- Results of technical editing can be modified by the user.

Limit condition A limit condition results from a limit module integrated in a simple module. This 
new module is called a module with limit condition(s).

Limit condition line Line that must be inserted in the limit module for drawing the needle allocation. 
This line is shown with a yellow background.

Limit module A limit module observes the needle allocation of the preceding needles and 
automatically inserts the necessary transitions from the pattern to the related 
module. A limit module can only be used in the pattern as part of a module with 
limit condition(s).

Limit module line When generating limit modules with limit condition(s), limit module lines are 
inserted to integrate limit modules. These lines are shown with a red back-
ground in the module editor.

Line with knitting instructions Knitting instructions for the CMS are written in SINTRAL. A CMS knitting pro-
gram is structured in lines with ascending numbering with SINTRAL information. 
Each program line begins with a line number, followed by the knitting information 
contained in the line.

Link A symbol with which a connection to a file or to a folder is created. When you 
double-click on a link, the original element is opened.

Local module A local module is a module present in the pattern, but that has not been saved in 
the module database.

Logical Zoom A virtual presentation of the fabric in which the right and left stitches are dis-
played visible next to each other.

Lost & Found Lost & Found is a module group in the module explorer. During a database 
check the links to the lost modules are saved in this module group.
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Lost module The term lost module refers to a module that no longer has a link to the data-
base.

Machine attributes The machine attributes allow you to make settings to the machine that are taken 
into account during technical editing.

Machine data The machine data are machine-specific correction values and settings.

Machine database The machine database is divided into the Stoll machine database and the custo-
mer machine database. All Stoll machines are stored in the Stoll machine data-
base. In the customer machine database you put together your own machine 
pool. The machine database is accessed via the machine explorer.

Machine Explorer All Stoll machines are managed in the machine explorer. You can put together 
your own machine pool from these machines.

Main drive The carriage assembly is driven via a toothed belt on the back of the CMS 
machine and via an electronically controlled motor. The carriage assembly is 
clamped onto the toothed belt and reverses only via the needles selected for 
knitting or stitch transfer. Here the carriage path is optimized by the RCR 
system, which results in a considerable production increase.

MC jacquard (*.jac) The MC jacquard (*.jac) is the jacquard program required by the machine in the 
text format which contains the jacquard symbols for the knitting program (Sin-
tral). The file can be displayed and edited as text in the program UltraEdit-32 or 
as a picture in the jacquard editor.
The MC jacquard is automatically generated and saved within the pattern for a 
pattern of the M1. It can be displayed or extracted from within the pattern (Sintral 
menu).

MC jacquard (*.jdv) The MC jacquard (*.jdv) is the jacquard program in the M1 format. The file can 
be displayed and edited as a picture in the jacquard editor.

Module A module is understood to be frequently used knitting sequences with the rela-
ted module parameters. Modules are stored in the module database and are 
managed by the module explorer. You can select the modules from the module 
bar or from the module explorer and insert them in your pattern.

Module Bar The modules from the "Favorites (module bar)" module group are available in 
the module bar.

Module color The module color is understood to be the yarn color of a module.

Module database All modules of the pattern workstation are stored in the module database. The 
module database is accessed via the module explorer and via the module bar.

Module echo A module echo is a display of the module size of the selected module. In the 
fabric view the module echo is shown as a picture of the module and in the tech-
nical view as a marking.

Module Explorer All module types are managed in the module explorer. Modules can be selected, 
displayed, edited, imported, exported, moved and deleted.

Module link Link of a module from the module database in module explorer and module bar 
or the connection of the module in the database to the individual uses of the 
module in various module groups.

Module positioning If a module is allocated to a color when importing a picture, then the modules 
can either be filled in a grid so that they are arranged directly above each other, 
or they can be filled in freely (without a grid). As the module very seldom fits 
exactly into the color area, insertion is possible with an edge covered by the 
module or a free edge.
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Module tree Presentation of the module links in the module explorer in a tree-like, hierarchi-
cal structure.

Multi gauge When knitting multi gauge articles, several gauges are realized in one fabric.

My machines Data of the Stoll knitting machines of the user’s own machine pool.

Narrowing The transferring of selvedge stitches toward the inside to generate the desired 
shape and size of the sleeve or body element. Following narrowing the stitch-
releasing needles are inactive, causing fewer needles to work over the width.

Needle Actions Needle actions are those characters that can be used to generate the module or 
pattern in the technical view.

Needle bed On the CMS flat knitting machine there are two needle beds, a front and a back 
bed, mounted relative to each other in the shape of a roof. The back needle bed 
can be offset to the side by up to two inches in both directions with a racking 
device by means of a step motor. The CMS spring latches are inserted in the 
grooves of the needle beds, and for needle selection the elements: coupling 
part, intermediate slider, selector jack with selector spring. The needles of the 
front needle bed are positioned at a gap opposite the needles in the back needle 
bed.
The CMS 330 TC4 operates with two additional beds. These are mounted hori-
zontally over the needle beds and are equipped with transfer parts. The transfer 
parts enable fast, lateral transfer of stitches by transferring these from the need-
les onto the opposite transfer parts and - following racking - back into the need-
les. Narrowed fully fashion fabric pieces and racking effects are knit extremely 
economically with this technique.

Needle density The k&w machines are available for knitting k&w articles in the special gauges 
5.2, 6.2 and 7.2. The same gauges are used for knitting multi gauge. The ordi-
nary machine gauge that would match the special gauge is called the needle 
density.

Needle hook gauge A needle can have a needle hook that does not match the gauge of the needle.

Needle layout An empty window in which only the needles are shown as dots. The needle 
actions can be drawn in here.

Network adapter (network card) Networking hardware of a computer

NP The stitch cam position determines the stitch size. The take-down cam is moved 
into the desired position by the step motor.

Offset The term "offset" is used when one needle bed is moved to the left or right rela-
tive to the other bed. The term "offset stitch" can also be used for the angled 
position of a knitting machine to the left or right.

Online help The entire help that you can run within the M1. The content matches that of the 
user manual.

Order menu The Order menu is a list of knitting orders that are worked through consecutively 
by the knitting machine. The making-up size and quantity for each order are 
specified in the Order menu. The Order menu can be edited in the M1 Pattern 
Workstation and saved as a text file with the ending *.ord (Order).

Overrun path The distance from the end point of the yarn carrier path to the yarn carrier stop 
position. The overrun path is automatically determined by the technical editing 
function and displayed in the yarn-carrier display bar of the technical view as a 
dashed line with a triangle as the end point in white. The length of the overrun 
path can be changed.
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Paste buffer Paste buffer of the M1 pattern workstation with the pattern elements that have 
been saved with the function "Picture in paste buffer". The contents of the paste 
buffer are displayed within the module bar in the Pattern elements module 
group.

Pattern elements Pattern areas that are temporarily saved in the clipboard (paste buffer) with the 
functions Copy and Cut, or have been imported to the paste buffer with the Pic-
ture function.

Pattern row A pattern row represents a block of grouped technical rows.

Pattern Row Presentation Presentation form in the Fabric and Technical view with which only the pattern 
rows are displayed.

Pattern-global Specifications and settings that are to apply to the entire pattern are referred to 
as pattern-global.

Pattern-local module group Module group within the module bar in which the modules from the pattern are 
contained.

Picking-up after pressing-off For machines of the series 4xx and 3xx - without comb take-down - the "Picking-
up after pressing-off" function is provided to enable a knitting start with an 
"empty needle bed". Either of the two knitting modes 1X1 or R-R is available for 
this purpose.

Picture import With the Import picture function you can import pictures in the BMP, TIF and 
PCX formats and generate a pattern, a pattern element or a shape in the size of 
the pictures.

Quickinfo Also called Tool Tip or Tip Text. A brief description of a screen element. The 
Quickinfo is displayed after a short time when the cursor is positioned on an ele-
ment.

Racking The movement of the needle bed from left to right - to generate a racking pattern 
- or to transfer the stitches when producing cable, aran and pointel patterns. 
Stepless racking of the back needle bed over 1, 2, 3 etc. needles is possible on 
the CMS machine with a maximum of 4 inches (100 mm), i.e. a maximum of 48 
needles for a gauge of 12. The racking position is electronically monitored and 
adjusted. For certain fabrics the stitches can be stretched with over and reverse 
racking.

RCR (intelligent carriage rever-
sal point/Rapid Carriage Return)

On the CMS machine models the length of the carriage stroke is automatically 
controlled by the computer. The knitting machine computer optimizes the pro-
duction output of the machine by automatically calculating the shortest carriage 
path for each knitting row (intelligent RCR system from STOLL).

Reference row The reference row specifies which row from the module is positioned on which 
row in the pattern.

Relief jacquard With a relief jacquard the various colors knit in any given area on only one 
needle bed (jacquard with transfer).

Round needles Needles with which the outer stitches on the fabric border are knit.

Row adjustment Sorting in the rows of a module while inserting them in the pattern.

Scaling Change the size of an area.

Selan Online communication system between Stoll knitting machines, pattern units 
and analysis computers.

Select Selection and marking of certain elements for further editing.
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Selected needle area (SEN) The Sintral command SEN=1-200 says that the knitting zone of needle 1 (left 
side of needle bed) extends to needle 200 (size of a fabric piece). If the last 
needle leaves the knitting system, the carriage assembly reverses immediately. 
The knitting zone may be different for each row. The SEN command is also used 
for multi-piece work. Example: three fabric pieces next to each other SEN1=1-
210; SEN2=310-520; SEN3=620-830.

Selection A selection is a marking within a pattern, a shape or in a dialog box.

Selection The selection of an area is called selection. The selected area is a pattern ele-
ment that can be edited further as a module. The selected area is shown lighter 
or marked with a frame or running frame.

Selection system The selection system chooses the needles for the needle action.
Each needle can carry out the following needle actions:
- Except for the activity (not knitting)
- Tuck
- Stitch
- Transfer - Delivering
- Transfer - Accepting
- Split-stitch - Receiving
- Split-stitch - Receiving

SEN Selected needle area. The Sintral command SEN=1-200 tells the CMS machine 
controller that the knitting zone of needle 1 (left side of needle bed) extends to 
needle 200 (one fabric piece). The SEN command is also used for multi-piece 
work.
Example: Three fabric pieces next to each other in the needle bed:
SEN1=1-210, SEN2=310-520, SEN3=620-830. This means that the first fabric 
piece ranges from needle 1 - 210, the second fabric piece from needle 310 - 520 
and the third fabric piece from needle 620 - 830.

Separation Separation refers to the dividing up of a yarn field.

Sequence A sequence is understood to be a repetition of knitting programs which are knit 
consecutively. Here the knitting programs are automatically read into the 
memory of the knitting machine consecutively. As a result, the knitting machine 
need not wait after completing a knitting program until the operating personnel 
has read in a new knitting program.

Shape A shape is a closed line curve that represents a fabric piece.

Shape attributes The color of the shape edge and the symbols from the shape tools toolbar are 
shape attributes.

Shape importation With shape importation you can import shapes in the DXF format for further use 
in the M1.

Shape View The shape view is used to show the shape. These can be edited with the icons 
from the Shape tools toolbar.

Single needle selection The needles are instructed with SINTRAL commands in the knitting program to 
carry out the required activity in accordance with the pattern, e.g.
"R" - all needles knit a stitch
"F" - all needles knit a tuck
"0" - all needles do not knit (0 = zero) etc.

Single-carriage machines Machines with 1 carriage.

Single-Jersey Jacquard Single-jersey jacquard is produced using the needles of only one needle bed.
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Single-jersey jacquard Single-jersey jacquard is produced using the needles of only one needle bed. 
Needles selected according to the pattern knit a jacquard pattern.

SINTRAL STOLL interpreter computer software for all CMS machines. A programming 
language developed by STOLL with terms usual in the knit goods industry for 
the commands.

Sintral functions Sintral functions (<name>.sin) can be added to the pattern. These are inserted 
in the knitting program by technical editing (Generate Sintral / Jacquard / Setup). 
They are not visible in the pattern itself. Examples of this are the transition bet-
ween the fabric pieces for Fully Fashion or the pattern start with which a corre-
sponding Sintral function is used instead of the module technology. The Sintral 
functions are managed in the pattern parameters and the technical row data.

Size table Several program lines within the knitting program to which the same cycle 
switch or counter is allocated. With the size table different sizes can be knit with 
only one knitting program.

Spacer No yarn carriers can be allocated to a module. To nevertheless be able to enter 
different yarn carrier actions, the placeholder is used.

Split function During the splitting process the stitch is divided during transfer so that only one 
of the two stitch legs is transferred to the accepting needle. As the transferring 
needle in the same knitting system immediately forms a stitch, the openings that 
otherwise occur during transfer are closed.

Start line (Shape editor) The start line is the first shape line in the basic shape shape element. It embo-
dies the starting width of the shape. When entered it is automatically allocated 
the basis function.

Starting conditions The start condition is part of the needle action with transfer. If one of these 
needle actions is used in the pattern, then it is checked whether the needle assi-
gnment to the preceding row has changed in this column. If the needle alloca-
tion has changed, then either "Transfer back" or "Transfer forward" is inserted 
on the start condition level. This is also referred to as "automatic transfer". If the 
needle allocation has not changed, then nothing is inserted on the start condi-
tion level.

Starting line (gore function) Tool in the gore function for converting an existing diagonal gore segment into a 
straight knitting zone.

Stitch Echo The pulling open of a selection is shown in the fabric view of the fabric presenta-
tion with selected stitches.

Stitch row A technical row consisting of the needle actions stitch and/or tuck and/or float 
and/or split-stitch.

STIXX STIXX is a device that measures the thread length used and corrects the stitch 
length by adjusting the take-down parts if necessary.

Stoll applications® With this knitting technology developed and patented by Stoll, multi-layer appli-
cations such as pockets and collars can be produced on a fabric. This results in 
major advantages in the areas of make-up, checking and deadline monitoring.

Stoll Explorer The Module explorer and Machine explorer are explorers developed by Stoll for 
the pattern workstation and are therefore called Stoll explorers. In the Module 
explorer the module database and in the Machine explorer the machine data-
base are displayed in a hierarchical structure.
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Stoll flexible gauge® With this knitting technology developed and patented by Stoll, fabrics with an 
extremely broad range of gauges can be produced with one and the same 
machine, without needle replacement or gauge conversion. This means maxi-
mum flexibility with a further reduction in investment costs to be able to react 
even more quickly and economically to new fashion trends.

Stoll knit and wear® This knitting technique, developed and patented by Stoll, enables you to knit 
complete articles in a fully-fashion shape. For example, pullovers complete with 
sleeves and a collar can be knitted and then put on directly after being removed 
from the machine in this way. Additional sewing work is not required.

STOLL Knit Memory Card The STOLL Knit Memory Card (KMC) is a special program and file system for 
saving pattern and system files. These pattern and system files can be read in 
the STOLL knitting machines.
KMC file systems can be saved on flash cards (KMCs) or in container files on 
other data carriers (floppy disks, hard disks).
KMC file systems can be managed with the program STOLL Knit Memory Card 
(Stcard Commander).

Stoll machines Data of all Stoll knitting machine models in the machine explorer.

Stoll multi-gauges® This knitting technology developed and patented by Stoll enables knitting of 2 or 
more gauges combined in one fabric. This eliminates the need for gauge con-
version, needle replacement and make-up work. This clearly reduces the 
through-put times.

Stoll multiflex® With this take-down system developed and patented by Stoll a reduced fabric 
distortion is realized with the variable adjustment of the contact pressure of the 
roller segments. All take-down components (main take-down, upper take-down 
and comb take-down) are freely programmable. Fault monitoring, e.g. during 
fabric cast-off, is carried out electronically.

Stoll Pattern Innovations® Knitting-related work procedures with a high fashion statement exclusively 
developed by Stoll. These include: Stoll multi-gauges®, Stoll applications®, Stoll 
racking effects®, Stoll knit and wear®, Stoll flexible gauge®.

Stoll racking effects® With this knitting technology developed and patented by Stoll, interesting pattern 
effects can be realized for multi-layer fabrics by knitting with the racked pattern 
at an angle. This achieves the same effects as those that can otherwise only be 
produced with machines with auxiliary needle beds. This technology can also be 
used with 2 or more gauges in one fabric.

Stoll touchcontrol® (TC) This technology developed and patented by Stoll enables the direct entry of 
commands by touching symbols on the machine display. The ordinary keyboard 
has been replace with a touch screen.

Take-down cams Controlling the needle take-down and specifying the stitch tension with it.

Tandem machines Machines with two carriages.

Tandem mode Two carriage assemblies are connected with a coupling rod. In the synchronized 
movement two fabric pieces with an identical pattern are produced.

TCP/IP (transmission control 
protocol/Internet protocol)

A series of network protocols that enables communication of different intercon-
nected computers and control systems. The basis for Internet communication.

Technical Assistant Dialog box for displaying the technical rules and for controlling technical editing.

Technical Editing Technical editing checks the pattern for errors and adds the remaining informa-
tion required for knitting. A knitting program (Sintral) can be generated from the 
result. You can influence technical editing. If technical editing is carried out 
several times for the pattern, it only represents a test run.
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Technical row Technical rows are the knitting rows and the transfer rows of the pattern. Conse-
cutive technical rows can be combined to form a pattern row. This is referred to 
as grouping.

Technical row data The technical row data are pattern data that do not absolutely have to be 
entered by the user. On the one hand, these data are partially automatically sup-
plemented during technical editing. On the other hand, these data are allocated 
by the user when he/she notices during knitting on the machine that the pattern 
cannot be knitted in a certain technical row without these data.

Technical Row Display Presentation form in the Technical view with which all technical rows are dis-
played, regardless of whether or not they are grouped. Only stitch rows are visi-
ble in the Fabric view.

Technical rules The individual steps of technical editing.

Technical textiles In addition to knitwear products, technical fabrics are a major application of the 
CMS flat knitting machines. Single needle control and holding-down technique 
enable mixing of knitting modes, materials and structures in one piece, and the-
refore the production of fully fashion fabrics and multi-dimensional bodies. In the 
process, the following materials are processed depending on the application 
and use: elastomeres, thermoplastics, glass and ceramic fibers, carbon fibers, 
metal wires, natural fibers and all technical yarns.

Technical view Graphic presentation of all needle actions present in the pattern.

Three-dimensional knitting Fabrics in the third dimension show a marked appearance in the area of outer-
wear. Multi-dimensional knitting is also used in the area "Technical knitted 
goods". For example, concave or convex sections (third dimension) and semi-
circular sections are achieved by knitting elliptical segments on each other with 
the gore technique, whereby a considerably larger number of stitches is knit in 
the center than at the edge of the segments.

Transfer The transfer of stitches (or tuck loops) is a process in which a stitch is transfer-
red from a front needle to an opposing back needle or vice versa. The transfer-
ring needle runs through the stitch-transfer cam truck in the knitting system, and 
the accepting needle the stitch-acceptance cam truck. Each stitch can be trans-
ferred completely or only with one stitch leg (splitting). Stitches are transferred to 
patterns, for example with transfer patterns or for fully fashion knitting, during 
narrowing or binding-off.

Transfer rows A technical row that only consists of the needle actions transfer and/or after-
pressing and/or casting off.

Virtual stitch draft The draft of fabrics with authentic-looking (graphically displayed) knitting stit-
ches on the screen of the pattern workstation (fabric view). This means that 
fabrics can be simulated and evaluated on the screen.

Wale The vertical row of stitches in a fabric (along the fabric length)

Widening If additional needles are brought into operation at the fabric border (widening), 
then the fabric becomes wider.

WMF Index Different fabric take-down values that are displayed in the knitting program via 
an index.

Yarn bridge A yarn bridge is the connection of an interrupted color surface with a jacquard 
generator or jacquard module.

Yarn carrier The task of the yarn carrier is to insert the knitting yarn for the stitch formation in 
the needles. To do this, it is routed from the yarn-carrier selection unit via the 
knitting system in the yarn insertion position via the needles.
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Yarn carrier field The yarn fields are grouped to form yarn carrier fields. Each new yarn carrier 
field results in the use of a new yarn carrier. The allocation can be influenced in 
the Yarn field allocation dialog box.

Yarn carrier path The distance to be covered by the yarn carrier. This is automatically determined 
by the technical editing function from the Insert action. The yarn carrier path is 
shown in the yarn-carrier display bar of the technical view as a continuous line in 
the yarn color. The start and end point can be changed.

Yarn carrier position The position in which the yarn carrier remains after knitting a stitch row.

Yarn carrier rails Double-profile metal rails mounted over the needle bed. Up to 32 yarn carriers 
are present on the four double yarn-carrier rails.

Yarn carrier selection The yarn carriers are selected by the yarn-carrier selection unit. They can be 
activated and deactivated, for example for applications in any required position 
along the yarn carrier rails. The information for this purpose is contained in the 
SINTRAL knitting program. The yarn carriers can, for example, automatically be 
moved into their home position for the new start of a fabric.

Yarn color To be able to allocate different yarns in the fabric as simply as possible and to 
make these areas visible, the yarns are represented with colors.

Yarn field A yarn field is a knitting area in which the same yarn is used. The yarns can be 
distinguished from each other with the yarn color and the yarn number. Yarn 
fields are necessary for determining the yarn carrier fields. Each yarn number is 
allocated its own yarn field. If the area of a yarn number is interrupted by 
another yarn, then several yarn fields are determined.

Yarn field allocation In the "Yarn field allocations" dialog box you influence "technical editing". For 
example, you group several yarn fields to form one yarn carrier field, or assign a 
yarn field 2 yarn carrier fields, which causes this area to be worked with two yarn 
carriers.

Yarn field view The yarn field view is used to clarify where in the pattern which yarn fields have 
been determined. With the Yarn field allocation dialog box the yarn carrier fields 
determined from the yarn fields can be organized differently.

Yarn float Yarn float refers to the thread length that covers one or several non-knitting 
needles during knitting. This stretches the non-working stitch of the stitch row 
formed previously and now resting in the needle. Vertical stitch rows are called 
wales. In the case of yarn floats to total number of stitches in the wales differs. 
This principle is also used when knitting a single-jersey color jacquard in which 
two or more colors are combined to form a color stitch row.

Yarn guide The yarn guide guides the knitting yarn from the bobbin to the needle.

Yarn number As the yarn colors can be changed individually, each yarn color has a yarn num-
ber to enable a clear differentiation of the yarns.

Yarn type A "yarn type" is allocated to the colors from the "Technical" color group in the 
"Yarn colors" toolbar. The yarn carriers with this yarn type are automatically 
entered in the yarn carrier allocation.

Zoom Zoom is understood to be the set picture size. This can be increased or 
decreased.
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